Table of contents

1 Introduction.................................................................................................................................................. 5
  1.1 About this document ................................................................................................................................. 5
    1.1.1 Description of the contents .................................................................................................................. 5
    1.1.2 List of revisions ................................................................................................................................... 5
    1.1.3 Conventions in this document ........................................................................................................... 6
  1.2 Versions of devices, firmware, software tools and drivers ......................................................................... 7
  1.3 Software package ....................................................................................................................................... 8
    1.3.1 Overview ........................................................................................................................................... 8
    1.3.2 Contents of the product DVD .............................................................................................................. 8
    1.3.3 How to use the product DVD .............................................................................................................. 10
    1.3.4 Notes on installing the USB Driver .................................................................................................... 11
  1.4 Documentation overview ............................................................................................................................ 12
  1.5 Legal notes .................................................................................................................................................. 13
    1.5.1 Copyright .......................................................................................................................................... 13
    1.5.2 Important notes .................................................................................................................................. 13
    1.5.3 Exclusion of liability ........................................................................................................................... 14
    1.5.4 Warranty ........................................................................................................................................... 14
    1.5.5 Export regulations ............................................................................................................................... 15
    1.5.6 Registered Trademarks ...................................................................................................................... 15

2 Safety........................................................................................................................................................... 16
  2.1 General note ............................................................................................................................................... 16
  2.2 Intended use ............................................................................................................................................... 16
  2.3 Personnel qualification ................................................................................................................................. 16
  2.4 References safety ...................................................................................................................................... 16
  2.5 Safety instructions to avoid personal injury ................................................................................................. 17
    2.5.1 Electrical shock hazard ....................................................................................................................... 17
    2.5.2 Danger of unintended starting up of machines ................................................................................... 17
  2.6 Safety instructions to avoid property damage ............................................................................................. 18
    2.6.1 General safety instructions concerning supply voltage ...................................................................... 18
    2.6.2 Device destruction by exceeding allowed supply voltage .................................................................. 18
    2.6.3 Electrostatic sensitive device ............................................................................................................. 19
  2.7 Labeling of safety messages ....................................................................................................................... 20

3 Device description EU5C-SWD-POWERLINK gateway ............................................................................... 21
  3.1 Function ................................................................................................................................................. 21
  3.2 Configuration .......................................................................................................................................... 22
  3.3 Interfaces ............................................................................................................................................... 23
  3.4 Diagnosis .............................................................................................................................................. 23
  3.5 Firmware and device description file ......................................................................................................... 24

4 Requirements for operation .......................................................................................................................... 25
  4.1 Network systems ..................................................................................................................................... 25
  4.2 Power supply ......................................................................................................................................... 25
    4.2.1 POW power connection ...................................................................................................................... 25
    4.2.2 AUX power connection ...................................................................................................................... 26

5 Device picture, connectors and LEDs ........................................................................................................... 27
Table of contents

6 Getting started ........................................................................................................... 33

7 Installing gateway .................................................................................................... 34

8 Configuring gateway .................................................................................................. 42

9 Configuring gateway in POWERLINK ....................................................................... 52

10 POWERLINK data communication ......................................................................... 56

11 Updating firmware .................................................................................................. 65

12 Firmware recovery via HTTP .................................................................................. 70

13 Technical data ......................................................................................................... 75
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.2</td>
<td>POWERLINK</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>List of figures</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>List of tables</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Contacts</td>
<td>81</td>
</tr>
</tbody>
</table>
1 Introduction

1.1 About this document

1.1.1 Description of the contents

This manual describes the Hilscher EU5C-SWD-POWERLINK SmartWire-DT Gateway. Here you will find information on how to install, configure and operate the gateway.

This manual is intended for automation technicians and engineers. Detailed knowledge of Ethernet POWERLINK is presumed. In addition, readers should also be familiar with the handling of the SmartWire-DT system.

**Important:**
- To avoid personal injuries or damage of electrical devices, please read this manual carefully before installing and using the EU5C-SWD-POWERLINK Gateway.
- Please first read chapter Safety [page 16].

1.1.2 List of revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2013-10-15</td>
<td>Created</td>
</tr>
<tr>
<td>2</td>
<td>2013-12-09</td>
<td>Section Diagnosis/Status Response revised.</td>
</tr>
<tr>
<td>3</td>
<td>2014-11-05</td>
<td>Chapter Firmware Recovery via HTTP added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section Software Package updated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description of POW LED in section Descriptions of the LEDs updated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section Contacts updated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Safety symbols revised according to ANSI.</td>
</tr>
<tr>
<td>4</td>
<td>2015-06-26</td>
<td>Design of safety messages updated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section Diagnosis/Status response revised and renamed as Error Entry: Error and status messages (diagnosis) [page 59].</td>
</tr>
</tbody>
</table>

Table 1: List of revisions
1.1.3 Conventions in this document

Notes, operation instructions and results of operation steps are marked as follows:

**Notes**

- **Note:**
  
  *<important note>*

- **Note:**
  
  *<simple note>*

- **<note, where to find further information>*

**Operation instructions**

1. *<operational step>*
   - *<instruction>*

2. *<operational step>*
   - *<instruction>*

**Results**

- *<intermediate result>*
- *<final result>*

For a description of the labeling of **Safety Messages**, see section *Labeling of safety messages* [page 20].
1.2 Versions of devices, firmware, software tools and drivers

The hardware revisions and software versions functionally belong together. This means that certain revisions of the hardware of the gateway need certain versions of firmware, software and drivers, in order to function properly.

This section lists the hardware revisions and the versions of the firmware, the configuration software and the drivers which functionally belong together and to which all instructions in this manual refer.

**Device and firmware**

This manual refers to the following hardware revision and firmware version of the EU5C-SWD-POWERLINK Gateway:

<table>
<thead>
<tr>
<th>Device type name</th>
<th>Protocol</th>
<th>Part number</th>
<th>Hardware revision</th>
<th>Firmware</th>
<th>Firmware version</th>
</tr>
</thead>
<tbody>
<tr>
<td>EU5C-SWD-POWERLINK</td>
<td>POWERLINK Controlled Node</td>
<td>9233.921</td>
<td>3</td>
<td>E030K0U0.nxf</td>
<td>1.0.x.x</td>
</tr>
</tbody>
</table>

*Table 2: Reference to hardware and firmware*

**Software tools**

This manual refers to the following software versions:

<table>
<thead>
<tr>
<th>Software</th>
<th>Manufacturer</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet Device Configuration Tool</td>
<td>Hilscher</td>
<td>1.501</td>
</tr>
<tr>
<td>Automation Studio</td>
<td>Bernecker + Rainer</td>
<td>3.0.90</td>
</tr>
<tr>
<td>SWD-Assist</td>
<td>Eaton</td>
<td>1.90</td>
</tr>
</tbody>
</table>

*Table 3: Reference to software tools*

**Drivers**

This manual refers to the following driver versions:

<table>
<thead>
<tr>
<th>Driver</th>
<th>File name</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB-Treiber für Windows</td>
<td>usbser.sys</td>
<td>Depending on Windows version</td>
</tr>
</tbody>
</table>

*Table 4: Reference to drivers*
1.3 Software package

1.3.1 Overview

You need the SWD-Assist software in order to configure the EU5C-SWD-POWERLINK gateway.

The software can be ordered separately from Hilscher under the product name EU5C-SWD-SW (order number 3233.920). The package contains the SmartWire-DT Gateway Solutions product DVD and a Mini-USB cable.

You can download the contents of the product DVD as ZIP file free of charge from our website www.hilscher.com > under Products > Partner Products > SmartWire-DT > EU5C-SWD-POWERLINK > Downloads > Software.

1.3.2 Contents of the product DVD

The SmartWire-DT Gateway Solutions product DVD contains software for all types of SmartWire-DT gateways. Depending on the gateway type you are using, you will need only certain features of the DVD.

The product DVD includes:

- Device description files
- Firmware
- Eaton SWD-Assist software
- Wizard for installing the software available on the DVD and for downloading the latest version of the SWD-Assist software from the internet
- Installation program for USB driver (USB driver is needed for connecting the gateway to a PC in order to use the Eaton SWD-Assist software)
- Installation program for the Hilscher Ethernet Device Configuration Tool
- Documentation in PDF format
- Installation program for Adobe Reader

---

**Note:**

A device description file for the EU5C-SWD-POWERLINK Gateway is not provided on the product DVD. The project-specific XDD device description file for the POWERLINK-Gateway has to be generated by the SWD-Assist software.
The product DVD has the following directories:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation</td>
<td>PDF manuals in German and English and installation program for Adobe Reader</td>
</tr>
<tr>
<td>EDS</td>
<td>Electronic device description files and bitmaps, to be imported directly into Master/Controller configuration software. <strong>Note:</strong> The device description file for the EU5C-SWD-POWERLINK Gateway has to be generated by the SWD-Assist software.</td>
</tr>
<tr>
<td>Firmware</td>
<td>Loadable gateway firmware</td>
</tr>
<tr>
<td>fscommand</td>
<td>Files for start screen of product DVD</td>
</tr>
</tbody>
</table>
| Setups & Drivers | SWD-Assist software  
Folder: SWD-Assist  
Wizard for installing the software available on the DVD and for downloading the latest version of the SWD-Assist software from the internet  
Folder: Setup  
Installation program for Ethernet Device Configuration Tool  
Folder: EnDeviceCfg  
Installation program (setup.exe) and .INF- and .CAT- files for Windows USB driver.  
Folder: USB Driver |

**Table 5: Directory of the product DVD**

---

**Note:**
You can use the wizard on the product DVD to download updates of the Eaton SWD-Assist software, or you can download SWD-Assist directly from the www.moeller.net website under **Support > Download Center**. Direct link: [http://downloadcenter.moeller.net/en/software.a487d8b7-da91-486f-b3ba-a7ca2035db99](http://downloadcenter.moeller.net/en/software.a487d8b7-da91-486f-b3ba-a7ca2035db99)
1.3.3 How to use the product DVD

Insert the **SmartWire-DT Gateway Solutions** product DVD into the DVD drive of your configuration PC.

If the auto start function of your DVD drive is enabled, the start screen of the DVD automatically opens. You can also start the DVD by double-clicking the **SmartWire.exe** file in the root directory of the DVD.

In the menu of the start screen of the DVD, click **Install Planning and Configuration Tools** to open a wizard for installing the software programs stored on the DVD. The wizard also helps you to download the latest version of the Eaton planning software SWD-Assist from the internet. It automatically checks for already installed software components (which e.g. might have been installed for an earlier project), and lists the missing components accordingly. The following options might be offered:

- **USB Driver**: installs USB driver for Windows on your PC.
- **Download Center SWD-Assist (manual update)**: connects your browser to a web page where you can download the latest version of the SWD-Assist software.
- **SWD Planning Software SWD-Assist Vx.xx**: installs the SWD-Assist software version provided on the DVD.
- **Ethernet Device Scanner/Configuration Tool**: installs the Hilscher Ethernet Device Configuration Tool.
- **GSDML, EDS, ESI files (HTML page)**: opens a web page containing links to the device description files.

**Note:**
A device description file for the EU5C-SWD-POWERLINK Gateway is not provided on the product DVD. The project-specific XDD device description file for the POWERLINK-Gateway has to be generated by the SWD-Assist software.

In the main menu of the start screen of the DVD, you can furthermore open a web page which provides an overview of all available documents (menu **Documentation**). You can also directly open the folder containing the device description files (menu **Open Electronic Device Description Files Directory**).
1.3.4 Notes on installing the USB Driver

If you intend to use the SWD-Assist software, you should first install the USB driver on your PC before you connect the gateway via USB.

To install the USB driver from the DVD, choose **Install Planning and Configuration Tools** in the DVD menu to open the installation wizard, and then select the **USB driver** option. As an alternative, you can use the Windows Explorer to open the `Setups & Drivers\USB Driver` folder on the DVD, and then double-click the `setup.exe` file. Just follow the instructions of the installation routine afterwards.

---

**Note:**
Under Windows XP, the installation process is not yet finished by the setup. The installation process has to be completed in the **Found new Hardware Wizard**, which automatically opens when you connect the gateway to a PC via USB cable for the first time (see below).

---

**Windows XP**

When you connect the gateway via USB for the first time to a PC running under Windows XP, the **Found New Hardware Wizard** opens:

- Answer the question **Can Windows connect to Windows Update...?**, with **No, not this time**. Then click **Next** button.
- If you have already carried out the setup of the USB driver (as recommended), you can ignore the wizard’s request to insert a CD or floppy disk. Answer the **What do you want the wizard to do?** question by selecting the **Install the software automatically** option, then click **Next** button.
- After the installation is complete, click **Finish** button.

**Windows 7 and 8**

The USB connection is instantly operative under Windows 7 and 8 if you have carried out the setup of the USB driver before first connecting the USB cable (as recommended).

**Uninstall USB Driver**

If you want to remove the USB driver from a PC running under Windows XP, choose **Start** menu > **Control Panel** > **Add or Remove Programs**, then select:

**Windows Driver Package – Hilscher GmbH (hilusbser) Ports** entry. Click **Change/Remove** button to uninstall the driver.

Under Windows 7 and 8, choose **Start** menu > **Control Panel** > **Uninstall a program**, then select:

**Windows Driver Package – Hilscher GmbH (hilusbser) Ports** entry. Click **Uninstall/Change** button to uninstall the driver.
### 1.4 Documentation overview

Besides this user manual at hand (path on product DVD: Documentation \english\2. Hardware\EU5C-SWD-POWERLINK UM xx EN.pdf), the following documents are also relevant for the user of the EU5C-SWD-POWERLINK gateway:

<table>
<thead>
<tr>
<th>Title</th>
<th>Contents</th>
<th>Publisher</th>
<th>Document ID</th>
<th>Path on product DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SmartWire-DT Units</strong></td>
<td>Information on engineering, installation and programming of the individual SmartWire-DT slaves.</td>
<td>Eaton</td>
<td>MN05006001Z-EN</td>
<td>Documentation\english\3.SmartWire-DT\SmartWire-DT – Units\MN05006001Z_EN.pdf</td>
</tr>
<tr>
<td><strong>SmartWire-DT The System</strong></td>
<td>Information on function, installation, commissioning and diagnostics of the SmartWire-DT system.</td>
<td>Eaton</td>
<td>MN05006002Z-EN</td>
<td>Documentation\english\3.SmartWire-DT\SmartWire-DT - The System\MN05006002Z_EN.pdf</td>
</tr>
<tr>
<td><strong>Ethernet Device Configuration</strong></td>
<td>Operating Instruction Manual of Hilscher Ethernet Device Configuration Tool.</td>
<td>Hilscher</td>
<td>DOC050402OIxxEN</td>
<td>Documentation\english\1.Software\Ethernet Device Setup Utility\Ethernet Device Configuration OI xx EN.pdf</td>
</tr>
<tr>
<td><strong>SWD-Assist Online help</strong></td>
<td>Online help for SWD-Assist planning software</td>
<td>Eaton</td>
<td>-</td>
<td>Included in SWD-Assist software</td>
</tr>
<tr>
<td><strong>B&amp;R Help Explorer – Automation Studio</strong></td>
<td>Online help for Automation Studio software</td>
<td>Bernecker + Rainer</td>
<td>-</td>
<td>Included in Automation Studio software</td>
</tr>
</tbody>
</table>

*Table 6: Documentation overview*
1.5 Legal notes

1.5.1 Copyright

© Hilscher 2013 – 2015, Hilscher Gesellschaft für Systemautomation mbH

All rights reserved.

The images, photographs and texts in the accompanying material (user manual, accompanying texts, documentation, etc.) are protected by German and international copyright law as well as international trade and protection provisions. You are not authorized to duplicate these in whole or in part using technical or mechanical methods (printing, photocopying or other methods), to manipulate or transfer using electronic systems without prior written consent. You are not permitted to make changes to copyright notices, markings, trademarks or ownership declarations. The included diagrams do not take the patent situation into account. The company names and product descriptions included in this document may be trademarks or brands of the respective owners and may be trademarked or patented. Any form of further use requires the explicit consent of the respective rights owner.

1.5.2 Important notes

The user manual, accompanying texts and the documentation were created for the use of the products by qualified experts, however, errors cannot be ruled out. For this reason, no guarantee can be made and neither juristic responsibility for erroneous information nor any liability can be assumed. Descriptions, accompanying texts and documentation included in the user manual do not present a guarantee nor any information about proper use as stipulated in the contract or a warranted feature. It cannot be ruled out that the user manual, the accompanying texts and the documentation do not correspond exactly to the described features, standards or other data of the delivered product. No warranty or guarantee regarding the correctness or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well as related user manuals, accompanying texts and documentation at all times and without advance notice, without obligation to report the change. Changes will be included in future manuals and do not constitute any obligations. There is no entitlement to revisions of delivered documents. The manual delivered with the product applies.

Hilscher Gesellschaft für Systemautomation mbH is not liable under any circumstances for direct, indirect, incidental or follow-on damage or loss of earnings resulting from the use of the information contained in this publication.
1.5.3  Exclusion of liability

The software was produced and tested with utmost care by Hilscher Gesellschaft für Systemautomation mbH and is made available as is. No warranty can be assumed for the performance and flawlessness of the software for all usage conditions and cases and for the results produced when utilized by the user. Liability for any damages that may result from the use of the hardware or software or related documents, is limited to cases of intent or grossly negligent violation of significant contractual obligations. Indemnity claims for the violation of significant contractual obligations are limited to damages that are foreseeable and typical for this type of contract.

It is strictly prohibited to use the software in the following areas:

- for military purposes or in weapon systems;
- for the design, construction, maintenance or operation of nuclear facilities;
- in air traffic control systems, air traffic or air traffic communication systems;
- in life support systems;
- in systems in which failures in the software could lead to personal injury or injuries leading to death.

We inform you that the software was not developed for use in dangerous environments requiring fail-proof control mechanisms. Use of the software in such an environment occurs at your own risk. No liability is assumed for damages or losses due to unauthorized use.

1.5.4  Warranty

Although the hardware and software was developed with utmost care and tested intensively, Hilscher Gesellschaft für Systemautomation mbH does not guarantee its suitability for any purpose not confirmed in writing. It cannot be guaranteed that the hardware and software will meet your requirements, that the use of the software operates without interruption and that the software is free of errors. No guarantee is made regarding infringements, violations of patents, rights of ownership or the freedom from interference by third parties. No additional guarantees or assurances are made regarding marketability, freedom of defect of title, integration or usability for certain purposes unless they are required in accordance with the law and cannot be limited. Warranty claims are limited to the right to claim rectification.
1.5.5 Export regulations

The delivered product (including the technical data) is subject to export or import laws as well as the associated regulations of different countries, in particular those of Germany and the USA. The software may not be exported to countries where this is prohibited by the United States Export Administration Act and its additional provisions. You are obligated to comply with the regulations at your personal responsibility. We wish to inform you that you may require permission from state authorities to export, re-export or import the product.

1.5.6 Registered Trademarks

Adobe Reader® is a registered trademark of Adobe Systems Incorporated.

Ethernet POWERLINK and B & R Automation Studio are trademarks of B&R, Bernecker + Rainer Industrie-Elektronik Ges.m.b.H, Eggelsberg, Austria.

SmartWire-DT® is a registered trademark of Eaton Corporation.

Windows® XP, Windows® 7 and Windows® 8 are registered trademarks of the Microsoft Corporation.

All other mentioned trademarks are property of their respective legal owners.
2 Safety

2.1 General note

The user manual, all accompanying texts and the documentation are written for the use of the products by educated personnel. When using the products, all safety instructions, property damage messages and all valid legal regulations have to be observed. Technical knowledge is presumed. The user has to assure that all legal regulations are obeyed.

2.2 Intended use

The purpose of the EU5C-SWD-POWERLINK Gateway described in this user manual is to create a connection between SmartWire-DT slaves and an overriding Managing Node (master device) in an Ethernet POWERLINK network.

2.3 Personnel qualification

The gateway must be installed, configured and removed by qualified personnel only. Job-specific technical skills for people professionally working with electricity must be present concerning the following issues:

- Safety and health at work
- Mounting and connecting of electrical equipment
- Measurement and analysis of electrical functions and systems
- Evaluation of the safety of electrical systems and equipment
- Installing and configuring IT systems

2.4 References safety

[S1] ANSI Z535.6-2006 American National Standard for Product Safety Information in Product Manuals, Instructions, and Other Collateral Materials


[S3] EN 61340-5-1 and EN 61340-5-2 as well as IEC 61340-5-1 and IEC 61340-5-2
2.5 Safety instructions to avoid personal injury

To ensure your own personal safety and to avoid personal injury, you must read, understand and follow the following safety instructions in this manual and all warning messages before you install and operate the gateway.

2.5.1 Electrical shock hazard

Take care of the following safety measures before installing or uninstalling the gateway:

- First disconnect the power plug of the device.
- Make sure that the device is disconnected from the power supply.
- Cover or enclose neighboring units that are live.

Devices that are designed for mounting in housings or control cabinets must only be operated and controlled after they have been installed with the housing closed. Desktop or portable units must only be operated and controlled in enclosed housings.

2.5.2 Danger of unintended starting up of machines

- Install automation devices and related operating elements in a way that they are well protected against unintentional operation.
- Emergency stop devices complying with IEC/EN 60204-1 must be effective in all operating modes of the automation devices. Unlatching the emergency-stop devices must not cause restart.
- You must take safety precautions (emergency switching off) in the external circuitry of the gateway and any power modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power supply to the contactor coils AUX.
- Measures should be taken to ensure the proper restart of programs interrupted after a voltage dip or failure. This should not cause dangerous operating states even for a short time. If necessary, emergency stop devices should be implemented.
- Wherever faults in the automation system may cause damage to persons or property, external measures must be implemented to ensure a safe operating state in the event of a fault or malfunction (for example, by means of separate limit switches, mechanical interlocks etc.).
2.6 Safety instructions to avoid property damage

To avoid damage to your gateway or your communication system, you must read, understand and follow the following safety instructions and all safety instructions and warnings in this manual concerning property damage, before you install and operate the gateway.

2.6.1 General safety instructions concerning supply voltage

- In safety-relevant applications the power supply providing power to the SmartWire-DT system must feature a PELV power feed module (protective extra low voltage).
- Switch off the power supply if you are reconnecting slaves in the SmartWire-DT system or reconnecting the ribbon cable connection. Otherwise the SmartWire-DT slaves can be destroyed!
- The gateway has protection against polarity reversal for the 24-V-DC-PW supply. However, if the gateway is connected via the serial interface to an earthed device (for example to a PC), the gateway can be destroyed, if the polarity of the power supply is reversed!
- The functional earth (FE) must be connected to the protective earth (PE) or to the potential equalization. The system installer is responsible for implementing this connection.
- Connecting cables and signal lines should be installed so that inductive or capacitive interference does not impair the automation functions.
- Suitable safety hardware and software measures should be implemented for the I/O interface so that a line or wire breakage on the signal side does not result in undefined states in the automation devices.

2.6.2 Device destruction by exceeding allowed supply voltage

The gateway must only be operated with the specified supply voltage.

- Make sure that the limits of the allowed range for the supply voltage are not exceeded. A supply voltage above the upper limit can cause severe damage of the gateway!
- A supply voltage below the lower limit can cause malfunction of the gateway!
- Ensure a reliable electrical isolation of the low voltage for the 24 volt supply. Only use power supply units complying with IEC 60364-4-41 (VDE 0100 Part 410) or HD 384.4.41 S2.

The allowed range for the supply voltage is indicated in section Technical data EU5C-SWD-POWERLINK gateway [page 75].
2.6.3 Electrostatic sensitive device

The gateway is sensitive to electrostatic discharge, which can cause internal damage and affect its normal operation. Therefore adhere to the necessary safety precautions for components that are vulnerable to electrostatic discharge when you install or remove the gateway. Follow the guidelines listed hereafter when you handle the gateway:

- Touch a grounded object to discharge potential static before you handle the gateway.
- Wear an approved grounding wrist strap.
- If possible, use a static-safe workstation.
- When not in use, store the device in appropriate static-safe packaging.
2.7 Labeling of safety messages

In this document the safety instructions and property damage messages are designed according both to the internationally used safety conventions as well as to the ANSI Z535 standard.

- The Section Safety Messages at the beginning of a chapter are pinpointed particularly and highlighted by a signal word according to the degree of endangerment. The kind of danger is specified exactly by the safety message text and optionally by a specific safety sign.

- The Integrated Safety Messages embedded in operating instructions are highlighted by a signal word according to the degree of endangerment. In the safety message, the nature of the hazard is indicated.

Signal words and safety signs in safety messages on personal injury

<table>
<thead>
<tr>
<th>Signal word</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER</td>
<td>Indicates a direct hazard with high risk, which will have as consequence death or grievous bodily harm if it is not avoided.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Indicates a possible hazard with medium risk, which will have as consequence death or (grievous) bodily harm if it is not avoided.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>Indicates a minor hazard with medium risk, which could have as consequence personal injury if it is not avoided.</td>
</tr>
</tbody>
</table>

Table 7: Signal words in safety messages on personal injury

<table>
<thead>
<tr>
<th>Safety sign</th>
<th>Sort of warning or principle</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Warning of lethal electrical shock</td>
</tr>
<tr>
<td></td>
<td>Principle: Disconnect the power plug</td>
</tr>
</tbody>
</table>

Table 8: Safety signs in messages on personal injury

Signal words and safety signs in safety messages on property damage

<table>
<thead>
<tr>
<th>Signal word</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTICE</td>
<td>Indicates a property damage message</td>
</tr>
</tbody>
</table>

Table 9: Signal words in safety messages on property damage

<table>
<thead>
<tr>
<th>Safety sign</th>
<th>Sort of warning or principle</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Warning of property damage by electrostatic discharge</td>
</tr>
</tbody>
</table>

Table 10: Safety signs in safety messages on property damage
3 Device description EU5C-SWD-POWERLINK gateway

3.1 Function

The EU5C-SWD-POWERLINK Gateway integrates a SmartWire-DT network into an Ethernet POWERLINK network. The Gateway creates a data connection between the participants (the slave devices) of the subordinate SmartWire-DT network and the Managing Node (the master device or PLC) of the superordinate POWERLINK network.

The gateway acts as master in the SmartWire-DT network on the one hand, and on the other hand as modular Controlled Node (slave device) in the POWERLINK network. It thereby presents each connected SmartWire-DT participant as individual module to the POWERLINK Managing Node.

The cyclic process data is exchanged transparently between both networks. 1000 Bytes of process input/output data can in sum be exchanged with up to 99 SmartWire-DT participants (slaves).
3.2 Configuration

There are three types of configurations that are relevant for commissioning and operating the EU5C-SWD-POWERLINK gateway.

The **actual configuration** is the current actual constellation of the devices at the SmartWire-DT bus connected to the SmartWire-DT interface of the gateway. It is always scanned after each restart of the gateway. This procedure cannot be influenced.

In case the actual configuration complies with the configuration envisaged for operation, the actual configuration can be captured as **target configuration** and stored zero-voltage safe in the device. This capturing and storing of the actual configuration as target configuration can be achieved either by pressing the configuration button located at the front panel of the gateway or by using the SWD-Assist software (for the position of the configuration button, see section *Device picture* [page 27]).

This target configuration is then available within the gateway even after power-off or restart of the device. If a target configuration has been stored, the gateway checks on each restart whether the actual configuration complies with the target configuration. In case the gateway detects inadmissible deviations, it will not go into operation. If the actual configuration deviates from the target configuration because of a device failure or removal on the SWD bus, the **SWD LED** on the gateway starts to blink red (for the position of the SWD LED, see section *Positions of the LEDs* [page 28]).

If no errors are detected, the gateway is in principle ready for operation, but remains in waiting until the so-called planned configuration is downloaded to the gateway via the SWD-Assist software.

Without a target configuration, the gateway will not go into operation. The target configuration therefore has to be generated

- when you commission the gateway for the first time,
- after replacing a SmartWire-DT slave or
- after deliberately changing the setup of the SmartWire-DT network in any other way.

The third configuration is the **planned configuration** (in this document also called **project configuration**). It is created by using the SWD-Assist software and contains the desired configuration and the parameters of the SmartWire-DT network. It can be manually created in SWD-Assist by adding the individual device symbols in the "workbench" window, or it can be automatically created by taking over (i.e. reading-in) the target configuration from the gateway. The latter method is less prone to errors and therefore recommended.

The project configuration has to be complemented in SWD-Assist with the device-specific parameters of the SWD slaves and the POWERLINK-specific parameters (i.e. the node ID of the gateway). It then has to be downloaded from the configuration PC to the gateway via USB, where it is stored (like the target configuration) zero voltage-safe in the flash memory of the device.
The gateway checks the project configuration against the target configuration after each restart. SWD-Assist lets you define individual SWD slaves in the project configuration as being “non-mandatory” (which means that these slaves are allowed to be missing in the target configuration). Thus project configuration and target configuration must not necessarily comply with each other, but must be compatible. The result of this checking is indicated by the Config LED on the gateway (for the position of the Config LED, see section Descriptions of the LEDs [page 29]).

In order to acquaint the gateway with the POWERLINK Managing Node within its POWERLINK configuration, you have to generate an XDD device description file out of the project configuration in SWD-Assist, and then and export it. This file contains the projected/planned configuration of the gateway in a standardized description format, which complies with general POWERLINK specifications. The XDD file then has to be imported into your POWERLINK engineering tool (e.g. Automation Studio by B & R). Afterwards, you can add the gateway in the engineering tool to an already existing POWERLINK project as Controlled Node and perform a data mapping for the contained I/O modules (i.e. the SmartWire-DT slaves). Finally, you can load the project onto your POWERLINK Managing Node.

3.3 Interfaces

The gateway features a SmartWire-DT interface (plug, 8-pole), a 2-port switch Ethernet interface (RJ45) for connecting POWERLINK, and a Mini-USB interface. Via the Mini-USB interface, the gateway can be accessed, configured and diagnosed with the SWD-Assist software.

3.4 Diagnosis

The gateway can be diagnosed by connecting the SWD-Assist software to the Mini-USB interface. For further information, please refer to the SWD-Assist online help.

The POWERLINK protocol also provides diagnostic functions. For further information, see section Diagnose/Status Response.
3.5 Firmware and device description file

The EU5C-SWD-POWERLINK Gateway is shipped with its most recent firmware already loaded. Which firmware version is loaded in the gateway at the time of delivery can be inferred from the device type label (see section Device type label [page 32]).

You can update the firmware from your configuration PC by using an ordinary web browser. A web server embedded in the gateway provides a special web page for updating the firmware. This web server can be accessed via the Ethernet interface of the Gateway. For more details on this, please refer to the chapter Updating firmware [page 65].

In case of a missing or defective firmware, a firmware “recovery” process is possible via HTTP. Please refer to the chapter Firmware recovery via HTTP [page 70].

A device description file in XDD format can be generated by the SWD-Assist software. It can then be imported into a POWERLINK engineering tool (like e. g. Automation Studio by B & R).
4 Requirements for operation

The following prerequisites must be fulfilled to operate the gateway:

4.1 Network systems

- SmartWire-DT network with maximum number of up to 99 participants/stations/slaves and maximum extension of up to 600 meters.
- Ethernet POWERLINK network with POWERLINK PLC (Managing Node). Maximum cable length for one segment (i.e. cable between two devices or hubs) is 100 meters.

4.2 Power supply

**WARNING**

Danger of unsafe operation of the system

In safety-relevant applications the power supply providing power for the SmartWire-DT system must feature a PELV power feed module (protective extra low voltage).

**WARNING**

Danger of unsafe operation of the system

You must take safety precautions (emergency switching off) in the external circuitry of the gateway and any power modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power supply to the contactor coils AUX.

**NOTICE**

Device destruction

Ensure a reliable electrical isolation of the low voltage for the 24 volt supply. Only use power supply units complying with IEC 60364-4-41 (VDE 0100 Part 410) or HD 384.4.41 S2.

**Important:**

Please take into consideration the total power consumption of your SmartWire-DT network and, if necessary, plan for an additional feeder module EU5C-SWD-PF2. You can find information on the power consumption in the operating manuals of the SmartWire-DT devices.
4.2.1 POW power connection

A Power supply of 24 V DC for the coupling unit and for the Smart-Wire-DT slave electronics is needed at the connection POW.

On the SmartWire-DT gateway, connect the POW and AUX supply voltages via separate miniature circuit-breakers or fuses:

**Miniature circuit-breaker 24 V DC for POW**

- Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN 60898:
  - Miniature circuit-breaker 24 V DC rated operational current 3 A; trip types C or Fuse 3 A, utilization class gL/gG
- Cable protection for cable AWG 24 in accordance with UL 508 und CSA-22.2 No. 14:
  - Miniature circuit-breaker 24 V DC rated operational current 3 A; Tripping characteristics C or Fuse 3 A

4.2.2 AUX power connection

If any switching devices are also to be connected, for example via the DIL-SWD-32-001/002 SmartWire-DT slaves, a 24 V DC supply will also be required at the AUX power connection. This provides the supply for activating the contactor coils. This supply must be protected by an automatic circuit-breaker (3A gG/gl or 3 A miniature circuit-breaker with a Z characteristic).

If switching devices with an activation power greater than 3 A are connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-PF2 must be used.

On the SmartWire-DT gateway, connect the POW and AUX supply voltages via separate miniature circuit-breakers or fuses:

**Miniature circuit-breaker 24 V DC for AUX**

- Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN 60898:
  - Miniature circuit-breaker 24 V DC rated operational current 3 A; trip type Z or Fuse 3 A, utilization class gL/gG
- Cable protection for cable AWG 24 in accordance with UL 508 und CSA-22.2 No. 14:
  - Miniature circuit-breaker 24 V DC rated operational current 2 A; Tripping characteristics Z or Fuse 2 A
5 Device picture, connectors and LEDs

5.1 Device picture

(1) 24 V power supply POW
(2) Ethernet POWERLINK interface (RJ45)
(3) LEDs communication status POWERLINK (see subsequent section for details)
(4) Mini-USB interface
(5) Configuration button
(6) LEDs gateway functions (see subsequent section for details)
(7) 24 V power supply AUX
(8) SmartWire-DT connection (plug, 8-pole)

Table 11: Front view EU5C-SWD-POWERLINK gateway
5.2 Positions and meaning of the LEDs

5.2.1 Positions of the LEDs

1. **POW**: System status
2. **APL**: Application status
3. **Config.**: Configuration status
4. **SWD**: SmartWire-DT status
5. **BS**: POWERLINK bus status
6. **BE**: POWERLINK bus error
7. **L/A**: LINK/Activity for channel 0
8. **L/A**: LINK/Activity for channel 1
9. Receive/Transmit (RX/TX) for channel 0
10. Receive/Transmit (RX/TX) for channel 1

Table 12: LEDs EU5C-SWD-POWERLINK gateway
5.2.2 Descriptions of the LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>POW</td>
<td>Duo LED yellow/green</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>yellow</td>
<td>On</td>
<td>Firmware and operating system are running.</td>
</tr>
<tr>
<td></td>
<td>(green/yellow)</td>
<td>Flashing</td>
<td>Second Stage bootloader is not able to load firmware. The device needs to be sent-in for servicing.</td>
</tr>
<tr>
<td></td>
<td>(green/yellow)</td>
<td>(green/yellow)</td>
<td>Backup firmware is active. The gateway needs a firmware recovery as described in chapter Firmware recovery via HTTP [p. page 70]</td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>On</td>
<td>ROM loader is not able to find bootable image. The device needs to be sent-in for servicing.</td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>Flashing</td>
<td>ROM loader is not able to find bootable image. The device needs to be sent-in for servicing.</td>
</tr>
<tr>
<td></td>
<td>(off)</td>
<td>Off</td>
<td>Power supply for device is missing or hardware defect.</td>
</tr>
<tr>
<td>APL</td>
<td>Duo LED red/green</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>On</td>
<td>The communication on POWERLINK and SmartWire-DT is in cyclic data exchange and the gateway function is executed.</td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>Flashing</td>
<td>Gateway is initialized, but the communication on POWERLINK or SmartWire-DT is not in cyclic data exchange.</td>
</tr>
<tr>
<td></td>
<td>(red)</td>
<td>Flashing</td>
<td>Gateway is initialized, but the SmartWire-DT configuration is missing or in error.</td>
</tr>
<tr>
<td></td>
<td>(off)</td>
<td>Off</td>
<td>Gateway has detected an error during the initialization: Missing configuration, error in configuration or internal error.</td>
</tr>
<tr>
<td>Config</td>
<td>Duo LED red/green</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>On</td>
<td>The project configuration complies with the target configuration. Data exchange between gateway and PLC via POWERLINK is possible.</td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>Flashing</td>
<td>The project configuration does not comply with the target configuration, but is compatible with it. Data exchange between gateway and PLC via POWERLINK is possible.</td>
</tr>
<tr>
<td></td>
<td>(red)</td>
<td>On</td>
<td>The project configuration and the target configuration are not compatible. Data exchange between gateway and PLC via POWERLINK is not possible.</td>
</tr>
<tr>
<td></td>
<td>(off)</td>
<td>Off</td>
<td>No communication with the POWERLINK PLC, or the gateway does not have a project configuration.</td>
</tr>
</tbody>
</table>

Table 13: Descriptions of the LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWD</td>
<td>Duo LED red/green/orange (orange = red/green at the same time)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>On</td>
<td>The actual configuration complies with the target configuration. Data exchange between gateway and SmartWire-DT slaves takes place.</td>
</tr>
<tr>
<td></td>
<td>(red)</td>
<td>Flashing</td>
<td>The gateway misses its target configuration or a necessary SmartWire-DT slave is missing or the target configuration does not comply with the actual configuration. <strong>No data exchange</strong> between gateway and SmartWire-DT slaves.</td>
</tr>
<tr>
<td></td>
<td>(green)</td>
<td>Flashing</td>
<td>Slave addressing is active (after power-on or download of a project configuration containing empty modules). <strong>No data exchange</strong> between gateway and SmartWire-DT slaves.</td>
</tr>
<tr>
<td></td>
<td>(red)</td>
<td>On</td>
<td>Short-circuit on the 15 V power supply or no SmartWire-DT slave is connected. <strong>No data exchange</strong> between gateway and SmartWire-DT slaves.</td>
</tr>
<tr>
<td></td>
<td>(orange)</td>
<td>Flashing</td>
<td>After having pressed the configuration button: The gateway reads the actual configuration and stores it as target configuration.</td>
</tr>
</tbody>
</table>

SmartWire-DT Gateway | EU5C-SWD-POWERLINK
© Hilscher 2013 – 2015
DOC130802UM04EN | Revision 4 | English | 2015-06 | Released | Public
<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>BS</td>
<td>Duo LED red/green</td>
<td>(off)</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(green)</td>
<td>Flickering: Controlled Node (gateway) is in basic Ethernet state</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Single Flash: Controlled Node (gateway) is in state “Pre-Operational 1”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Double Flash: Controlled Node (gateway) is in state “Pre-Operational 2”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Triple Flash: Controlled Node (gateway) is in state “ReadyToOperate”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>On: Controlled Node (gateway) is in state “Operational”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Blinking: Controlled Node (gateway) is in state “Stopped”</td>
</tr>
<tr>
<td>BE</td>
<td>Duo LED red/green</td>
<td>(off)</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(red)</td>
<td>On: Controlled Node (gateway) has detected an error</td>
</tr>
<tr>
<td>L/A (RJ45)</td>
<td>LED green</td>
<td>(green)</td>
<td>On: Link: Gateway has connection to Ethernet</td>
</tr>
<tr>
<td>Ch0 &amp; Ch1</td>
<td></td>
<td>(green)</td>
<td>Flashing: Activity: Gateway sends/receives Ethernet frames</td>
</tr>
<tr>
<td>Numbers in</td>
<td></td>
<td>(off)</td>
<td>Off: Gateway has no connection to Ethernet</td>
</tr>
<tr>
<td>picture: (7) &amp; (9)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(RJ45)</td>
<td>LED yellow</td>
<td>(yellow)</td>
<td>-: This LED is not used</td>
</tr>
<tr>
<td>Ch0 &amp; Ch1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numbers in</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>picture: (8) &amp; (10)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 14: Description of the LEDs (2)
5.3 Pinning of the Real-Time Ethernet interface

The following picture shows the pinning of the POWERLINK interface of the gateway.

![Ethernet Pinning](image)

**Figure 2: Pinning of the Ethernet interface (RJ45)**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TX +</td>
<td>Transmit Data +</td>
</tr>
<tr>
<td>2</td>
<td>TX –</td>
<td>Transmit Data –</td>
</tr>
<tr>
<td>3</td>
<td>RX +</td>
<td>Receive Data +</td>
</tr>
<tr>
<td>4</td>
<td>TERM</td>
<td>Bob Smith Termination</td>
</tr>
<tr>
<td>5</td>
<td>TERM</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>RX –</td>
<td>Receive Data –</td>
</tr>
<tr>
<td>7</td>
<td>TERM</td>
<td>Bob Smith Termination</td>
</tr>
<tr>
<td>8</td>
<td>TERM</td>
<td></td>
</tr>
</tbody>
</table>

**Table 15: Ethernet interface channel 0 and channel 1 pin assignment (RJ45)**

**Note:**
The Ethernet interface supports auto crossover.
5.4 Device type label

Each EU5C-SWD-POWERLINK gateway carries a device type label, which provides the following information:

1. Version of firmware (at time of delivery)
2. Information on power supply for switching devices (AUX)
3. Information on power supply for Gateway and Smart-Wire-DT slaves (POW)
4. Information on wire gauge of power supplies
5. Operating ambient temperature
6. Device type name
7. Part number
8. Hardware revision number
9. Serial number

Table 16: Device type label EU5C-SWD-POWERLINK
6 Getting started

The following table provides an overview of the steps necessary for installing and commissioning the EU5C-SWD-POWERLINK Gateway.

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>For details see</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Install gateway</td>
<td>Chapter Installing gateway [page 34]</td>
</tr>
<tr>
<td>1.1</td>
<td>Take safety precautions</td>
<td>Section Safety messages [page 34]</td>
</tr>
<tr>
<td>1.2</td>
<td>Mount gateway onto top hat rail</td>
<td>Section Mounting gateway onto top hat rail [page 35]</td>
</tr>
<tr>
<td>1.3</td>
<td>Connect gateway to power supply</td>
<td>Section Connecting gateway to power supply [page 38]</td>
</tr>
<tr>
<td>1.4</td>
<td>Connect gateway to SmartWire-DT network</td>
<td>Section Connecting SmartWire-DT [page 40]</td>
</tr>
<tr>
<td>2</td>
<td>Configure gateway</td>
<td>Chapter Configuring gateway [page 42]</td>
</tr>
<tr>
<td>2.1</td>
<td>Configure SmartWire-DT network in gateway</td>
<td>Section Configuring SmartWire-DT network in gateway (creating target configuration) [page 42]</td>
</tr>
<tr>
<td>2.2</td>
<td>Install SWD-Assist and USB driver on configuration PC</td>
<td>Section Installing SWD-Assist and USB driver on configuration PC [page 44]</td>
</tr>
<tr>
<td>2.3</td>
<td>Connect configuration PC to gateway via USB</td>
<td>Section Connecting configuration PC via USB [page 46]</td>
</tr>
<tr>
<td>2.4</td>
<td>Configure gateway project in SWD-Assist</td>
<td>Section Configuring gateway in SWD-Assist (creating project configuration) [page 47]</td>
</tr>
<tr>
<td>2.5</td>
<td>Download project configuration to gateway</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Configure gateway in POWERLINK</td>
<td>Chapter Configuring gateway in POWERLINK [page 52]</td>
</tr>
<tr>
<td>3.1</td>
<td>Create XDD device description file for gateway in SWD-Assist</td>
<td>Chapter Configuring gateway in POWERLINK [page 52]</td>
</tr>
<tr>
<td>3.2</td>
<td>Import XDD device description file in POWERLINK engineering tool</td>
<td></td>
</tr>
<tr>
<td>3.3</td>
<td>Configure gateway in POWERLINK engineering tool</td>
<td></td>
</tr>
<tr>
<td>3.4</td>
<td>Download POWERLINK configuration to PLC</td>
<td></td>
</tr>
<tr>
<td>3.5</td>
<td>Connect gateway to POWERLINK network</td>
<td>Section Connecting POWERLINK [page 41]</td>
</tr>
</tbody>
</table>

Table 17: Getting started
7 Installing gateway

7.1 Safety messages

![WARNING]

Electrical shock

Please observe the following safety messages when you install and handle the gateway:

- First disconnect the power plug of the device.
- Make sure that the power supply is off at the device.
- Cover or enclose neighboring units that are live.

---

![NOTICE]

Electrostatic Sensitive Device

The gateway is sensitive to electrostatic discharge, which can cause internal damage and affect its normal operation. Therefore adhere to the necessary safety precautions for components that are vulnerable to electrostatic discharge, when you install or handle the gateway:

- Do not touch the metal pins of the connectors of the gateway.
- Touch a grounded object to discharge potential static.
- Wear an approved grounding wrist strap.
- If available, use a static-safe workstation.
- When not in use, store the device in an appropriate static-safe packaging.
7.2 Mounting gateway

No tools are required for mounting the EU5C-SWD-ETHERCAT Gateway onto a top hat rail. The back of the gateway (1) carries a spring-fitted bolt (2) by which the gateway can be clamped to the rail (3).

Figure 3: Mounting principle of the gateway

7.2.1 Mounting gateway onto top hat rail

To mount the gateway onto the top hat rail, proceed as follows:

**WARNING** Electrical shock: Make sure that the gateway is disconnected from any power supply! Cover or enclose neighboring units that are live!

- Tilt the gateway slightly and hook it into the upper railing from above, thereby pushing down the gateway with slight force, in order to overcome the resistance of the spring in the bolt.

Hook gateway to upper railing
Keep on pushing the gateway downwards and tilt it back into vertical position, thereby hooking the gateway into the lower railing.

Let go of the gateway. The spring inside the bolt automatically pushes the gateway upwards into the railings, thereby fixing the gateway to the top hat rail.
7.2.2 Removing gateway from top hat rail

To remove the gateway from the top hat rail, proceed as follows:

⚠️ **WARNING** Electrical shock: Make sure that the gateway is disconnected from any power supply! Cover or enclose neighboring units that are live!

- Push down the gateway with slight force (to overcome the resistance of the spring in the bolt), then unhook the gateway first from the lower railing and then from the upper railing.

Unhook gateway
7.3 Connecting gateway to power supply

**DANGER**

**Danger of lethal injuries by unexpected starting up of motors or machinery!**

If you have already integrated devices into a system, secure the operating range of any connected parts of the system against access, so that nobody is endangered by motors or machinery starting up unexpectedly.

**WARNING**

**Danger of unsafe operation of the system**

In safety-relevant applications the power supply providing power for the SmartWire-DT system must feature a PELV power feed module (protective extra low voltage).

**WARNING**

**Danger of unsafe operation of the system**

You must take safety precautions (emergency switching off) in the external circuitry of the gateway and any power modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power supply to the contactor coils AUX.

**Important:**

Please take into consideration the total power consumption of your SmartWire-DT network and, if necessary, plan for an additional feeder module EU5C-SWD-PF2. You can find information on the power consumption in the operating manuals of the SmartWire-DT devices.

- Connect the 24 V DC voltage to the **POW** terminals on the front side of the gateway. The **POW** connection provides the voltage for the gateway itself and for the SmartWire-DT slave electronics.

**Note:**

For the 15 V supply of the SmartWire-DT slaves, the gateway contains an additional power feed module with an amperage of 0.7 A.
If necessary, connect the 24 V DC voltage for the contactor coils to the AUX terminals on the front side of the gateway.

![Gateway power supply diagram]

Figure 4: Gateway power supply

**Note:**
The AUX supply is required if any switching devices are also to be connected, for example, via the DIL-SWD-32-001/002 SmartWire-DT slaves. The AUX connection provides the supply for activating the contactor coils. This supply must be protected by an automatic circuit-breaker (3A gG/gl or 3 A miniature circuit-breaker with a Z characteristic). If switching devices with an activation power greater than 3 A are connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-PF2 must be used.

**Potential conditions between the components**
The entire SmartWire-DT system operates on a common supply voltage. Provide a common star point for the earth wiring. In this way, the various slaves in the SmartWire-DT system will not be electrically isolated from one another. The POWERLINK network and the SmartWire-DT system are electrically isolated from one another.
7.4 Connecting SmartWire-DT

- Connect the SmartWire-DT network to the gateway. To do so, use the SmartWire-DT cable SWD4-100LF8-24 and the SWD4-8MF2 relevant blade terminal or prefabricated cables of type SWD4-(3/5/10)F8-24-2S.

![Connecting SmartWire-DT to gateway](image)

**NOTICE**

**Device destruction**

Switch off the power supply before you are reconnecting slaves in the SmartWire-DT system or reconnecting the ribbon cable connection. Otherwise the SmartWire-DT slaves can be destroyed!

Detailed instructions on adapting the SmartWire-DT external device plug (SWD4-8SF2-5) to the 8 pole Smart-Wire-DT cable are provided in chapter *Fitting external device plugs SWD4-8SF2-5* of the manual *SmartWire-DT – The System*, MN05006022Z-EN (previously AWB2723-1617en).
7.5 Connecting POWERLINK

- Connect the RJ45 plug of the POWERLINK cable to one of the Ethernet connectors on the gateway.

![Figure 6: Connecting POWERLINK to gateway](image)

<table>
<thead>
<tr>
<th>Important</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please observe the following notes on POWERLINK cabling:</td>
</tr>
<tr>
<td>- Use only hubs, no switches.</td>
</tr>
<tr>
<td>- Maximum cable length in a segment (allowed space between individual devices/hub) is 100 meters.</td>
</tr>
</tbody>
</table>

7.6 EMC-conformant wiring of the network

Undesired faults can occur on the bus due to electromagnetic interference. This can be minimized beforehand by the implementation of suitable EMC measures. These include:

- EMC-conformant system configuration,
- EMC compliant cable routing,
- Measures that do not allow the occurrence of large differences in potential and
- correct installation of the POWERLINK system (cables, connection of the bus connectors, etc.)

The effects of electromagnetic interference can be significantly reduced by fitting a shield.

For more detailed information on this, please refer to the IAONA *Industrial Ethernet -Planning and Installation Guide* by IAONA e.V. Magdeburg, Germany.
8 Configuring gateway

For data exchange between the gateway and the POWERLINK Managing Node, the gateway needs valid target and project configurations of the SmartWire-DT network. This chapter describes how to create and store these configurations in the gateway.

8.1 Configuring SmartWire-DT network in gateway (creating target configuration)

When you commission the gateway, you have to read-in the actual configuration of the SmartWire-DT network (i.e. the line-up of the participants/devices connected to the SWD bus) and store it as target configuration.

Reading and storing the SmartWire-DT network configuration takes place by pressing the configuration button on the gateway (for the position of the configuration button, see section Device picture [page 27]). All SmartWire-DT slaves are re-addressed in ascending order by this process. As an alternative, you can generate and store the target configuration by using the SWD-Assist software (the gateway must be connected to SWD-Assist via USB).

This process should only take place in the case of:

- initial commissioning,
- replacement of a defective slave or
- deliberate change to the configuration.

**NOTICE**

Hazard of device damage by disruption of voltage supply while creating target configuration!

Do not interrupt the voltage supply while creating the target configuration of the gateway. Power failure during a writing process in the file system can cause severe malfunctioning of the device.

**Important:**

If there is a faulty configuration and the configuration button is pressed, only the slaves up to the failed device are addressed and stored. Use of the remaining slaves is not possible until the defective slave has been replaced and the configuration has been read-in again by pressing the configuration button.

The remanently stored target configuration is compared with the current configuration (actual configuration) each time the gateway is restarted and during bus operation. If the gateway recognizes that a required SmartWire-DT slave cannot be reached or a wrong slave type is determined, the gateway will not go into operation or stops operating. This depends in each case on the setup of the network which has been defined in the planned/project configuration. In case of error, the SmartWire-DT status LED (SWD LED) starts to blink in red (for the position of the SWD LED, see Positions of the LEDs [page 28]).
If a SmartWire-DT slave has failed, the SmartWire-DT network can still be operated with the remaining slaves, depending on the settings in the planned/project configuration (even after a repeated power up of the gateway). The failure is reported to the application.

Prerequisites for reading-in the SmartWire-DT configuration are:

- All SmartWire-DT slaves are connected to the SmartWire-DT line.
- The SmartWire-DT network is connected to the gateway.
- The voltage POW is applied to the gateway and the power LED POW is on.
- The voltage AUX is applied (if necessary).
- The SmartWire-DT status LEDs of the individual SmartWire-DT slaves are on or are flashing.
- The POWERLINK network is disconnected from the gateway by removing the RJ45 plug from the Ethernet interface of the gateway.

To read-in the SmartWire-DT configuration proceed as follows:

- Make sure that POWERLINK is disconnected from the gateway.
- Press the configuration button on the gateway for at least two seconds (for the position of the configuration button, see section Device picture).

**Note:**
Take care to push-in the button properly. You have to feel and overcome a slight resistance at the end when pushing the button into the gateway, otherwise the button won’t trigger.

The SmartWire-DT status LED (SWD LED) on the gateway begins to flash orange. The SmartWire-DT status LEDs on the SmartWire-DT slaves also flash. All slaves are addressed in sequence, the complete configuration is stored retentively as gateway target configuration.

**Hazard of device damage by disruption of voltage supply while creating target configuration!**

Do not interrupt the voltage supply while creating the target configuration of the gateway. Power failure during a writing process in the file system can cause severe malfunctioning of the device.

The SmartWire-DT status LED (SWD LED) on the gateway shows steady green.
8.2 Installing SWD-Assist and USB driver on configuration PC

You need the SWD-Assist software on your configuration PC in order to create, parameterize and download a project configuration to the gateway. With SWD-Assist, you can also perform a diagnosis of the SmartWire-DT network and create an XDD device description file, which can be imported into your POWERLINK engineering tool for the purpose of configuring the POWERLINK Managing Node.

In the installation wizard of the SmartWire-DT Gateway Solutions DVD, you can install the version of the SWD-Assist software delivered on the DVD, or you can choose to be directed to an internet website from which you can download the latest version of SWD-Assist (if available).

In order to establish a USB connection between SWD-Assist and the gateway, you also need to install the USB driver on your configuration PC. An installation program for the USB driver is delivered on the SmartWire-DT Gateway Solutions DVD. It contains all components needed for the installation of the driver under Windows XP, Windows Vista, Windows 7 and Windows 8. It detects whether the 32 bit or the 64 bit version of the driver needs to be installed.

It is recommended to use the installation program to install the USB driver. It is also recommended to install the USB driver before you connect the gateway to your configuration PC via USB for the first time ("software first" principle).

Step-by-step Instructions

To install the software on your configuration PC, proceed as follows:

- Insert the SmartWire-DT Gateway Solutions DVD into your local DVD-ROM drive.
- If the “Auto Play” function of your Windows PC is enabled, the start screen of the DVD is displayed.

---

**Note:**

As an alternative, you can also open the start screen of the DVD by double-clicking the `SmartWire.exe` file in the root directory of the DVD.

- In the menu of the start screen, click **Install Planning and Configuration Tools**.
The **SmartWire-DT Installation Wizard** opens:

![SmartWire-DT Installation Wizard](image)

**Figure 7: SmartWire-DT Installation Wizard**

### Note:

The wizard automatically checks for already installed software components (which e.g. might have been installed for an earlier project), and lists the missing components accordingly.

- Select the appropriate installation options.
- Read the license agreement, then select **License agreement read and accepted**.
- Click **Execute**, then follow the instructions of the installation program.

### Note:

Under Windows XP, the installation process of the USB driver is not yet finished after having executed the driver setup. The installation process has to be completed in the **Found New Hardware Wizard**, which automatically opens when you connect the gateway to your configuration PC via USB cable for the first time (see following section).
8.3 Connecting gateway to configuration PC via USB

- Make sure that the gateway is connected to a voltage supply.
- Connect the Mini USB interface of the gateway with a USB interface of your configuration PC (for the position of the USB interface on the gateway, see section Device picture [page 27]).

**Windows XP:**

When you connect the gateway via USB for the first time to a PC running under Windows XP, the Found New Hardware Wizard opens:

- Answer the question Can Windows connect to Windows Update...?, with No, not this time. Then click Next button.
- If you have already carried out the setup of the USB driver (as recommended), you can ignore the wizard’s request to insert a CD or floppy disk. Answer the What do you want the wizard to do? question by selecting the Install the software automatically option, then click Next button.
- Windows copies the driver files to the Windows directories.
- After the installation is complete, click Finish button.

**Windows 7 and 8:**

If you have carried out the setup of the USB driver before first connecting the USB cable (as recommended), the installation will automatically be finished. Afterwards, the USB connection is instantly operative.
8.4 Configuring gateway in SWD-Assist (creating project configuration)

This section describes how to create and parameterize the **project configuration** (also called **planned configuration**) in SWD-Assist. This project configuration afterwards has to be downloaded to the gateway, in order to make it operative.

You can create the project configuration in SWD-Assist by manually adding the individual SWD participants symbols from the device catalog to the SWD string in the “workbench” window, or it can be automatically created by taking over (i. e. reading-in) the target configuration from the gateway (for a description of how to create the target configuration, see section **SmartWire-DT-Netzwerk in Gateway konfigurieren (Soll-Konfiguration erzeugen)** [page 42]).

This section describes the easier and faster method of automatically taking over the target configuration from the gateway.

1. Start SWD-Assist.
   - In the Windows **Start** menu, choose **All Programs > Eaton > SWD-Assist**.
   - The SWD-Assist software opens.
   - If the **SWD-Assist catalogue selection** dialog window appears, choose **Eaton EMEA** option and click **OK** button.
   - SWD-Assist opens in the **Project View**:

![Start Window of SWD-Assist](image)

**Figure 8: Start Window of SWD-Assist**

2. Create online connection to gateway.
   - To change from the **Project View** to the **Communication View**, choose **View > Communication View** from the menu bar, or click ![Communication View](image) button in the icon bar.
The **Communication View** opens:

![Communication View in SWD-Assist](image1)

- In the **Interface** drop-down list below **Connection setup**, select the COM port of your configuration PC to which you have connected the gateway via USB. You can recognize the correct port by the entry next to the COM port number (**Hilscher EU5C-SWD**).
- Click **Online** button.
- SWD-Assist establishes the online connection and reads-in the target configuration which had been stored in the gateway. The SWD devices belonging to the target configuration are depicted as blue symbols connected to the SWD bus:

![Target Configuration in SWD-Assist](image2)
Note:
If no target configuration has been stored in the gateway yet, you can create it now by clicking the **Renew** button in the **Target configuration** area in the left window. Thereby, the actual configuration (i.e. the current line-up of the devices connected to the SmartWire-DT network) is read-in, stored as target configuration in the gateway and transferred to SWD-Assist.

3. Generate project configuration from target configuration.
   - In the **Target configuration** area, click **Device => PC** button to save the target configuration from the device in SWD-Assist, in order to adapt it as project configuration (i.e. planned configuration).
   - Answer the security question with **Yes**.
   - In the **Connection setup** area, click **Offline** button.

4. Edit project configuration.
   - To change from **Communication View** back to **Project View** click button or press Ctrl+Alt+1 on your keyboard.
   - In the **Project View**, the former target configuration is now displayed as project configuration (i.e. planned configuration):

![Figure 11: Planned Configuration in SWD-Assist: Set Device Parameters](image)

   - In the **Workbench** window, select an SWD slave device, then open the **Device Parameters** tab in the **Properties field** window (located below the **Workbench** window) and determine whether the device should be a **Required module** and whether it **Can be replaced with universal module**.
5. Set POWERLINK parameters in project configuration.
   - In the **Workbench** window, select the EU5C-SWD-POWERLINK gateway.

   ![Figure 12: Planned Configuration in SWD-Assist: Set POWERLINK Parameters of Gateway](image)

   - Then open the **Powerlink parameters** tab in the **Properties field** window (located below the **Workbench** window) and enter the **Node-ID**, by which the gateway should be reached in the POWERLINK network.

6. Transfer project configuration to gateway.
   - To change from the **Project View** to the **Communication View**, choose **View > Communication View** from the menu bar, or click **button in the icon bar.
   - The Communication View opens.
   - In the **Connection setup** area of the Communication View, click **Online** button.
   - SWD-Assist re-establishes an online connection, reads-in the target configuration from the gateway again and displays it in the **Workbench** window.

**Note:**
Before downloading the project configuration, you can let SWD-Assist compare it with the target configuration stored in the gateway by clicking the **PC = Device?** button in the **Target configuration** area.
In the Planned configuration area, click PC => Device button to transfer the project/planned configuration via USB to the gateway.

Note:
The project configuration is stored in the gateway along with the target configuration. Any old project configuration file that might have existed in the gateway up to this point will be overwritten. If an old project configuration file exists in the gateway, you can let SWD-Assist compare it with the new project configuration by clicking the PC = Device? button in the Planned configuration area before downloading the new one.

The project configuration is copied to the gateway and stored there non-volatile. If the project configuration complies with the target configuration, the Config LED starts to show steady green light after a few seconds (see also section Positions and meaning of the LEDs [page 28]).
9 Configuring gateway in POWERLINK

In order to acquaint the gateway with the POWERLINK Managing Node within its POWERLINK configuration, you need an XDD device description file. This file contains the projected/planned configuration of the gateway in a standardized description format, which complies with general POWERLINK specifications.

You can generate the XDD file in **SWD-Assist** from your project configuration and import it into your POWERLINK engineering tool, e.g. **Automation Studio**. There you can add the gateway as Controlled Node to an already existing POWERLINK project and perform a data mapping for the projected I/O modules (i.e. the SmartWire-DT devices). Afterwards you can load the POWERLINK project onto your **POWERLINK Managing Node**.

1. Generate XDD device description file in SWD-Assist.
   - Open the project in SWD-Assist. (If you have just recently copied the project configuration to the gateway – see preceding section – change from the **Communication View** back to the **Project View**.)
   - The Project View shows the project configuration:

```
Figure 13: Planned configuration in SWD-Assist
```

- In the **menu**, select **Project > Generate XDD file**...
- The **Save XDD file** dialog window opens.
- Choose the directory where you want to store the XDD file and enter a file name, then click **Save**.
2. Import XDD device description file into Automation Studio.
   - Open your POWERLINK project in Automation Studio.
   - In the menu of Automation Studio, choose **Tools > Import Fieldbus Device...**
   - A file selection dialog window opens.
   - Select the XDD device description file, then click **Open**.
   - The XDD device description file is imported.

3. Add gateway to the POWERLINK project.
   - In the right window, select the Managing Node of your POWERLINK project.

   ![POWERLINK project in Automation Studio](image)

   **Figure 14:** POWERLINK project in Automation Studio

   - Open the context menu and choose **Insert...**
   - The **Select controller module** dialog window opens:

   ![Select controller module dialog](image)

   **Figure 15:** Select controller module dialog in Automation Studio

   - Make sure that the **Insert module** option is selected.
   - Scroll the list for the Gateway XDD entry and select it. After selecting the entry, click **Next**.
The **Module Parameter** dialog window opens:

![Module Parameter dialog window](image)

- In the **Enter node number** field, enter the **Node-ID** which you have assigned to the gateway in the project configuration of SWD-Assist.
- Click **Next**.
- The **Module Parameter** dialog window closes and the gateway is displayed in the POWERLINK project:

![Gateway in POWERLINK project](image)
4. Map I/O data.
   - In the left window, select the gateway.
   - Open context menu and select **Open I/O Mapping**.

![Figure 18: Open I/O mapping](image)

In the right window, a list featuring the in- and outputs of the SmartWire-DT slaves opens:

![Figure 19: I/O Mapping of SWD slaves](image)

   - Link the I/O data to variables.
   - Save the project.

5. Load POWERLINK project to PLC via Ethernet.
   - In the menu, choose **Project > Transfer To Target** to compile the project and load it onto the POWERLINK PLC.
   - The project is compiled and loaded to the PLC.
10 POWERLINK data communication

10.1 Acyclical communication

The POWERLINK Managing Node can exchange acyclic data with individual SmartWire-DT slaves via the gateway and the Object Index 0x3000. For SDO Write (acyclic output), i.e. for writing data to a SWD slave (e.g. a read request), the Sub-Index 1 is provided. For SDO Read (acyclic input), i.e. for reading requested data from a SWD slave, the Sub-Index 2 is provided.

10.1.1 SDO Write (acyclic output)

10.1.1.1 Read request

Elements SDO Write – read request

For writing a read request, use Object Index 0x3000 together with Sub-Index 1 and the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Data type</th>
<th>Value range</th>
<th>Value example</th>
<th>Value example in hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave Address</td>
<td>Address of the SWD slave that you want to read (i.e. the address defined in the project configuration)</td>
<td>uint8</td>
<td>1…99</td>
<td>5</td>
<td>0x05</td>
</tr>
<tr>
<td>SWD Index</td>
<td>SWD-specific index of the SWD slave. Determines what kind of data you want to read, e.g. error counter or firmware version.</td>
<td>uint8</td>
<td>0…255</td>
<td>127</td>
<td>0x7F</td>
</tr>
<tr>
<td>Request Type</td>
<td>Type of request: Read or Write Request. A read request must have the value 0</td>
<td>uint8</td>
<td></td>
<td>0</td>
<td>0x00</td>
</tr>
<tr>
<td>Length</td>
<td>Maximum length of the expected response (in bytes)</td>
<td>uint8</td>
<td>1…120</td>
<td>120</td>
<td>0x78</td>
</tr>
</tbody>
</table>

Table 18: Elements read request SDO Write

Example of SDO Write – read request

In case the POWERLINK Managing Node wants to read the error counter (SWD Index 127) of the 5th SmartWire-DT slave (slave address 5), and the expected response should not be longer than 120 Bytes, the SDO Write sent to the gateway must feature the following values:

<table>
<thead>
<tr>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Index 0x3000</td>
</tr>
<tr>
<td>Sub-Index 0x01</td>
</tr>
<tr>
<td>Elements</td>
</tr>
<tr>
<td>Slave Address 0x05</td>
</tr>
<tr>
<td>SWD Index 0x7F</td>
</tr>
<tr>
<td>Request Type 0x00</td>
</tr>
<tr>
<td>Length 0x78</td>
</tr>
</tbody>
</table>

Table 19: Example read request SDO Write
10.1.1.2 Write request

**Elemente SDO Write – write request**

For writing a write request to the SmartWire-DT slave, use **ObjectIndex 0x3000** together with **Sub-Index 1** and the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Data type</th>
<th>Value range</th>
<th>Value example</th>
<th>Value example in hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave Address</td>
<td>Address of the SWD slave (i.e. the address defined in the project configuration)</td>
<td>uint8</td>
<td>1…99</td>
<td>5</td>
<td>0x05</td>
</tr>
<tr>
<td>SWD Index</td>
<td>SWD-specific index of the SWD slave. Determines where you want write data.</td>
<td>uint8</td>
<td>0…255</td>
<td>127</td>
<td>0x7F</td>
</tr>
</tbody>
</table>
| Request Type  | Type of request: Read or Write Request. A write request must have the value 1. | uint8     | Read Request = 0  
                     |                                               |           | Write Request = 1 | 1                  | 0x01                 |
| Length        | Length of the data to be written (in bytes).                               | uint8     | 1…120       | 1             | 0x01                 |
| Data          | Data to be written.                                                         | uint8     | (...)        | 0             | 0x00                 |

*Table 20: Elements write request SDO Write*

**Example of SDO Write – write request**

In case the POWERLINK Managing Node wants to reset the error counter (SWD Index 127) of the 5th SmartWire-DT slave (slave address 5), the SDO Write sent to the gateway must feature the following values:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Sub-Index</th>
<th>Elements</th>
<th>Slave Address</th>
<th>SWD Index</th>
<th>Request Type</th>
<th>Length</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x3000</td>
<td>0x01</td>
<td></td>
<td>0x05</td>
<td>0x7F</td>
<td>0x01</td>
<td>0x01</td>
<td>0x00</td>
</tr>
</tbody>
</table>

*Table 21: Example write request SDO Write*
10.1.2 SDO Read (acyclic input)

Elements SDO Read

The requested data can be read by using **ObjectIndex 0x3000** together with **Sub-Index 2**. The response features the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Data type</th>
<th>Value range</th>
<th>Value example</th>
<th>Value example in hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave Address</td>
<td>Address of the SWD slave of which data has been read.</td>
<td>uint8</td>
<td>1…99</td>
<td>5</td>
<td>0x05</td>
</tr>
<tr>
<td>SWD Index</td>
<td>Address of the SWD slave of which data has been read.</td>
<td>uint8</td>
<td>0…255</td>
<td>127</td>
<td>0x7F</td>
</tr>
<tr>
<td>Request Type</td>
<td>Type of request. A read request has the value 0.</td>
<td>uint8</td>
<td>Read Request = 0</td>
<td>Write Request = 1</td>
<td>0</td>
</tr>
<tr>
<td>Length</td>
<td>Length of the received response in bytes</td>
<td>uint8</td>
<td>1…120</td>
<td>120</td>
<td>0x78</td>
</tr>
<tr>
<td>Data</td>
<td>Actual data which has been read according to SWD Index, e. g. error counter or firmware version.</td>
<td>uint8 [120]</td>
<td>(...)</td>
<td>(...)</td>
<td>(...)</td>
</tr>
<tr>
<td>State</td>
<td>State of the response.</td>
<td>uint8</td>
<td>Idle = 0</td>
<td>In Progress = 1</td>
<td>Finished = 2</td>
</tr>
<tr>
<td>Error Code</td>
<td>Error detected by the SWD master (i. e. by the gateway)</td>
<td>uint32</td>
<td>No error = 0</td>
<td>JOBID_BUFFER_FULL = 0x00000000</td>
<td>JOB_DENIED = 0x00000003</td>
</tr>
</tbody>
</table>

Table 22: Elements SDO Read

Example SDO Read

In case the response is finished and no error was detected, the **SDO Read** (which is sent back by the gateway to the Managing Node in order to answer the **SDO Write**) features the following values:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Object Index</th>
<th>Sub-Index</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Slave Address</td>
<td>SWD Index</td>
<td>Request Type</td>
</tr>
<tr>
<td>0x3000</td>
<td>0x02</td>
<td>0x05</td>
<td>0x7F</td>
</tr>
</tbody>
</table>

Table 23: Example SDO Read
10.2 Error Entry: Error and status messages (diagnosis)

10.2.1 Overview

Errors and status changes of the SmartWire-DT network and errors occurring in individual SWD slaves are reported by the gateway via Error Entry object 0x1003.

The quantity of the current diagnoses can be read from the object 0x1003/0. Individual diagnoses are presented in detail from 0x1003/1 onwards.

The gateway stores each error message in its message buffer, from where it is deleted only after the corresponding error has been resolved (Error Reset). Resolved errors are also reported by the gateway to the POWERLINK Managing Node by means of an Error Entry.
Each **Error Entry** consists of 20 bytes and has the following structure:

<table>
<thead>
<tr>
<th>Field (according to POWERLINK specification)</th>
<th>Byte</th>
<th>Function (according to gateway implementation)</th>
<th>Description/range of values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Entry Type</strong></td>
<td>0</td>
<td><strong>Entry Type</strong></td>
<td>is always 0x70</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td><strong>Entry Type</strong></td>
<td>is always 0x00</td>
</tr>
<tr>
<td><strong>Error Code</strong></td>
<td>2</td>
<td><strong>Message Type</strong></td>
<td>May contain one of the following two values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0xFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>incoming message about an error of an individual SWD slave or error/status change of the Gateway/SWD network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>error of an individual SWD slave has been resolved (Error Reset). <strong>Note</strong>: this does not apply to gateway/SWD bus error resets, which are indicated by the vanishing of the <strong>error flags</strong>.</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td>3</td>
<td><strong>Address</strong></td>
<td>Address of the concerned device in the SmartWire-DT network:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Gateway/SWD master (used for messages about errors/status changes of the gateway/SWD network).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x01...0x63</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SWD slave 1 to 99 in the SWD network (used for messages concerning individual SWD slave devices).</td>
</tr>
<tr>
<td><strong>Time Stamp</strong></td>
<td>4</td>
<td><strong>Time Stamp</strong></td>
<td>SoC Nettime from the cycle when the error/event was detected. For details see POWERLINK specification.</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Additional Information</strong></td>
<td>12</td>
<td><strong>Diagnosis Code</strong></td>
<td>In case of <strong>Address</strong> (byte 3) (\geq 0x01) (error of individual SWD slave), this byte features a diagnostic code specifying the nature of the error. For details see section <strong>Error messages (diagnosis) of individual SWD slaves</strong> [page 61].</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In case of <strong>Address</strong> (byte 3) (= 0x00) (SWD network error/status change message issued by the gateway), this byte is not used (= 0x00). The nature of the SWD network error/status message is specified in the <strong>Error Flags</strong> (bytes 15 and 16), not in the diagnosis code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In case of <strong>Message Type</strong> (byte 2) (= 0x00) (resolved error/error reset of individual SWD slave), this byte specifies the error that has been resolved.</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td><strong>Not used/reserved</strong></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td><strong>Not used/reserved</strong></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td><strong>Error Flags</strong></td>
<td>In case of <strong>Address</strong> (byte 3) (= 0x00) (SWD network error/status change message issued by the gateway), these bytes feature error flags specifying the nature of the error/status change. In case of messages about resolved SWD bus errors, the flag in the corresponding bit disappears. For details see section <strong>SWD bus error and status messages generated by the gateway</strong> [page 63].</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td>In case of <strong>Address</strong> (byte 3) (\geq 0x01) (error of an individual SWD slave), these error flags are not used (= 0x00).</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td><strong>Not used/reserved</strong></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td><strong>Not used/reserved</strong></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td><strong>Not used/reserved</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Table 24: Structure of Error Entry**
10.2.2 Error messages (diagnosis) of individual SWD slaves

New ("incoming") errors are signaled to the POWERLINK Managing Node by the value 0xFF in the Message Type field (byte 2) of the Error Entry. The Address of the device reporting the error is provided in the Address field (byte 3) of the Error Entry: the values 0x01 to 0x63 represent the consecutively numbered SWD slaves from device 1 to device 99.

The nature of the error is indicated in the Diagnosis Code field (byte 12) of the Error Entry (the Error Flag fields [bytes 15 and 16] are not used in this case). The diagnostic codes are defined by the manufacturers of the individual SWD devices and can thus differ from device to device, you therefore have to look for the definitions of the codes in the user manual of the corresponding device (for devices manufactured by Eaton, for example, this would be the manual SmartWire-DT modules, MN05006001Z-EN).

The subsequent table provides some examples of diagnostic codes of SmartWire-DT slave devices.

<table>
<thead>
<tr>
<th>Diagnosis Code</th>
<th>Meaning</th>
<th>Used by</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>No diagnostic message active</td>
<td>All devices that support the extended diagnosis</td>
</tr>
<tr>
<td>0x10</td>
<td>Contact in middle position</td>
<td>RMQ</td>
</tr>
<tr>
<td>0x11</td>
<td>Contact short-circuit</td>
<td>RMQ</td>
</tr>
<tr>
<td>0x13</td>
<td>Output overload</td>
<td>I/O module</td>
</tr>
</tbody>
</table>

Table 25: Examples of diagnostic codes of SWD slaves

In case of a resolved error of an individual SmartWire-DT slave, the Message Type field (byte 2) contains the value 0x00, thus signaling to the POWERLINK Managing Node the error reset of the slave. The Address field (byte 3) again contains the address of the concerned device.

Example: Error Entry for new ("incoming") error/diagnosis of SWD slave

If an I/O module placed on position 5 in the SmartWire-DT network (i.e. Address [byte 3] = 0x05) detects an output overload, (i.e. Diagnosis Code [byte 12] = 0x13), the telegram looks as follows:

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Error Code</th>
<th>Time Stamp</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Diagnosis Code</td>
</tr>
<tr>
<td>Byte 0: 0x70</td>
<td>Byte 1: 0x00</td>
<td>Byte 2: 0xFF</td>
<td>Byte 3: 0x05</td>
</tr>
</tbody>
</table>

Table 26: Error Entry for new ("incoming") error/diagnosis of SWD slave
Example: Error Entry for resolved error/diagnosis of SWD device (Error Reset)

If the same I/O module reports that the output is not overloaded any longer (output overload error has been reset), the Error Entry looks as follows:

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Error Code</th>
<th>Time Stamp</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Message Type</td>
<td>Address</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Byte 0</td>
<td>Byte 1</td>
<td>Byte 2</td>
<td>Byte 3</td>
</tr>
<tr>
<td>0x70</td>
<td>0x00</td>
<td>0x05</td>
<td>0xXX</td>
</tr>
</tbody>
</table>

Table 27: Error Entry for resolved error of SWD slave
10.2.3 SWD bus error and status messages generated by the gateway

In cases of messages issued by the gateway concerning errors or status changes of the SmartWire-DT network, the **Message Type** field (byte 2 of the **Error Entry**) has the value **0xFF**, and the **Address** field (byte 3 of the **Error Entry**) has the value **0x00**.

The nature of the error/status change is specified in the **Error Flags** (bytes 15 and 16) of the Error Entry (the **Diagnosis Code** field [byte 12] is not used in this case).

The following **Error Flags** are currently defined:

<table>
<thead>
<tr>
<th>Byte (of Error Entry)</th>
<th>Bit</th>
<th>Hex</th>
<th>Relevance</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>0</td>
<td>0x01</td>
<td>Error</td>
<td>SWD: Necessary SmartWire-DT slave is missing</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0x02</td>
<td>Warning</td>
<td>SWD: Optional SmartWire-DT slave is missing</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0x04</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>0x08</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0x10</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0x20</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>0x40</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>0x80</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Byte (of Error Entry)</th>
<th>Bit</th>
<th>Hex</th>
<th>Relevance</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>0</td>
<td>0x01</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0x02</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0x04</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>0x08</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0x10</td>
<td>Info</td>
<td>SWD: The use of compatible slaves is allowed</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0x20</td>
<td>Info</td>
<td>SWD: All slaves are registered as “optional”</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>0x40</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>0x80</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**Table 28: Error Flags in case of bus error/status messages generated by the gateway**

**Important:**

Please note that resolved SWD bus errors (unlike error messages coming from individual SWD slaves) will not be signaled by the value **0x00** in the **Message Type** field (byte 2 of the **Error Entry**), the **Message Type** field value will anyway remain at value **0xFF**. This means that in cases of resolved bus errors – as in cases of “incoming” bus errors – the **Message Type** field value (byte 2 of the **Error Entry**) remains at **0xFF** and the **Address** field value (byte 3 of the **Error Entry**) remains at **0x00**. Whether the error has been resolved or not, can be recognized only by checking whether the corresponding error flag has disappeared.
Example: Error Entry for new ("incoming") error of SWD bus

If a mandatory SmartWire-DT slave is missing, the Error Entry looks as follows:

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Error Code</th>
<th>Time Stamp</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Error Code</th>
<th>Time Stamp</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Byte 0 | Byte 1 | Byte 2 | Byte 3 | Byte 4 | Byte 5 | Byte 6 | Byte 7 | Byte 8 | Byte 9 | Byte 10 | Byte 11 | Byte 12 | Byte 13 | Byte 14 | Byte 15 | Byte 16 | Byte 17 | Byte 18 | Byte 19 |
|---------|---------|--------|--------|--------|--------|--------|--------|--------|--------|---------|---------|---------|---------|---------|---------|---------|---------|---------|
| 0x70    | 0x00    | 0xFF   | 0x00   | 0xXX   | 0xXX   | 0xXX   | 0xXX   | 0xXX   | 0xXX   | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    |

Table 29: Error Entry for incoming error on SWD bus

Example: Error Entry for resolved SWD bus error (Error Reset)

If the gateway reports that the mandatory SmartWire-DT slave is not missing any longer (i.e. device has returned on the bus), the Error Entry looks as follows:

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Error Code</th>
<th>Time Stamp</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Error Code</th>
<th>Time Stamp</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Byte 0 | Byte 1 | Byte 2 | Byte 3 | Byte 4 | Byte 5 | Byte 6 | Byte 7 | Byte 8 | Byte 9 | Byte 10 | Byte 11 | Byte 12 | Byte 13 | Byte 14 | Byte 15 | Byte 16 | Byte 17 | Byte 18 | Byte 19 |
|---------|---------|--------|--------|--------|--------|--------|--------|--------|--------|---------|---------|---------|---------|---------|---------|---------|---------|---------|
| 0x70    | 0x00    | 0xFF   | 0x00   | 0xXX   | 0xXX   | 0xXX   | 0xXX   | 0xXX   | 0xXX   | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    | 0x00    |

Table 30: Error Entry in case of resolved SWD bus error
11 Updating firmware

11.1 Overview

The EU5C-SWD-POWERLINK Gateway is shipped with its most recent firmware already loaded. The version of the loaded firmware is stated on the device type label.

The integrated web server of the gateway provides a function to update the firmware of the gateway by HTTP via its Ethernet interface. All you need is a PC with an ordinary web browser connected to the gateway via Ethernet. When you perform a firmware update, the old firmware file in the gateway will automatically be overwritten. The project configuration and the target configuration in the gateway remain untouched by the firmware update.

**NOTICE**

Hazard of device damage by disruption of voltage supply during firmware update!

Do not interrupt the voltage supply while updating the firmware of the gateway. Power failure during a writing process in the file system can cause severe malfunctioning of the device.

**Note:**

In case of a missing or defective firmware (which is indicated by a green POW LED), the “regular” firmware update process described in this chapter is not working. In this case, proceed as described in chapter *Firmware recovery via HTTP* [page 70].
11.2 IP Address of gateway

In order to connect to the WebServer, you need to know the IP address of the gateway. On shipment, the default IP address of the gateway is 0.0.0.0. On commissioning, the gateway receives its IP address with the project configuration which you have created and downloaded to the gateway by using the SWD-Assist software. POWERLINK uses the IP address 192.168.100.x, appended by the individual Node ID (x) of the device. Thus, if you have defined Node ID 10 in the project configuration of the gateway, the gateway will have the IP address 192.168.100.10 after downloading the project configuration to the device.

Using the Ethernet Device Configuration Tool

Apart from POWERLINK, you can assign a temporary IP-address to the gateway by using the Hilscher Ethernet Device Configuration Tool and the netIDENT protocol. This temporary IP address is stored volatile in the gateway and is thus lost after power-off at the device. You can install this tool on your configuration PC by choosing the Install Planning and Configuration Tools option in the menu of the start screen of the product DVD, and then selecting the Ethernet Device Scanner/Configuration Tool option in the opening SmartWire-DT Installation Wizard (as an alternative, you can also double-click the EnDevConfigTool.msi file in the Setups and Drivers\EnDeviceCfg folder).

For information about how to use this tool, please refer to the operating instruction manual Ethernet Device Configuration, which is stored on the product DVD in the Documentation\english\1.Software\Ethernet Device Setup Utility directory.

Note:
Before you can use the Ethernet Device Configuration Tool to assign a temporary IP address, you first have to perform a special reset operation on the gateway, in order to deactivate the POWERLINK connection. For this special reset, you must briefly disconnect the gateway from the voltage supply and keep the configuration button pushed in for two to three seconds while reconnecting the voltage supply. The BS and BE LEDs will automatically turn off after successful reset (for the positions of the configuration button and the LEDs on the gateway, see section Device picture [\ page 27]).

After having set the temporary IP address and having updated the firmware in the gateway via web browser and WebServer, you must perform an ordinary reset of the gateway.
11.3 Prerequisites

- The gateway is connected to a power supply.
- The gateway is connected to an IP network via its Ethernet interface.
- PC with web browser connected to the IP network.
- The IP address of the gateway is compatible to the Ethernet subnet of the PC.
- You know the IP address of the gateway.

**Note:**
The current version of the firmware does not provide options to customize the user authentication of the web server by creating own groups, users or passwords.

11.4 Step-by-step instructions for updating firmware

1. Open web page for firmware update.
   - Start the web browser on your configuration PC.
   - In the address bar of your browser, enter the URL of the gateway: http://<IP address>
   - The home page of the WebServer opens.
   - In the navigation header of the web page, click **FirmwareUpdate**.

**Note:**
You can also open the firmware update page by entering the IP address http://<IP address>/fwupdate in the address bar of your browser.

- The following web page opens:

   **Firmware Identification**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Name</th>
<th>Version</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>SmartWire-DT POWERLINK</td>
<td>1.0.9.0</td>
<td>28.8.2013</td>
</tr>
</tbody>
</table>

   **Firmware Update**

   Choose the new firmware file (nxf) you want to install: [Browse]

   Submit your file by clicking on "transfer". The transfer will take a few seconds.

   **WARNING:** Do not interrupt power or disconnect cable from the system while the transfer is in progress!

   [Transfer] [Cancel]

*Figure 20: Firmware update via HTTP (as depicted in Internet Explorer)*
The Firmware Identification section displays the following parameters of the firmware currently loaded in the gateway:

- **Channel**: Location (port) of firmware
- **Name**: Name of loaded firmware
- **Version**: Version of loaded firmware
- **Date**: Date of creation of loaded firmware

The Firmware Update section features the following control elements:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse…</td>
<td>Opens the file selection dialog</td>
</tr>
<tr>
<td>Transfer</td>
<td>Uploads selected firmware file to the device</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels firmware update</td>
</tr>
</tbody>
</table>

*Table 31: Controls in Firmware Update Page*

2. Select new firmware file.

- Click **Browse…** button, to open a dialog window for selecting the firmware file.
- Navigate to the directory in which the firmware file is stored, select the file, and then click **Open**.

**Note:**
The name of the firmware file for the EU5C-SWD-POWERLINK gateway is E030K0U0.nxf

- Path and name of the selected file are displayed in the field next to the **Browse…** button.

3. Download firmware file to gateway.

**NOTICE**

**Hazard of device damage by disruption of voltage supply during firmware update!**

Do not interrupt the voltage supply while updating the firmware of the gateway. Power failure during a writing process in the file system can cause severe malfunctioning of the device.

- Click **Transfer** button to download the new firmware file to the gateway.

- After you have started the upload by clicking the **Transfer** button, the validity of the firmware file is being checked by the system. If the file fails the validity check, the file will not be stored in the gateway and an error message will be displayed. If the file passes, the old firmware file in the gateway is overwritten by the new firmware. Afterwards, the WebServer requests a reset, in order to start the new firmware.
11.5 Resetting gateway

After firmware download, you must reset the gateway in order to start the new firmware. If you have assigned a temporary IP address to the gateway with the Ethernet Device Configuration Tool, please note that the gateway loses this address after reset. The gateway then can be reached again under the IP address defined in the project configuration. If no project configuration is present in the device, the gateway falls back to its default IP address 0.0.0.0.

To reset the device, proceed as follows:

1. Open web page for reset.
   - In the navigation header of the web page, click **Reset**.

   **Note:** You can also open the reset page by entering the IP address http://<IP address>/reset in the address bar of your browser.

   The following web page opens:

   **Device Reset**
   
   Initializing a device reset will cause the device to reboot. A reboot will let the device stop all communications immediately. Established connections will drop.

   Before you initiate a reset make sure that your system is in idle state and operated under maintenance condition in order to prevent system damages.

   Device parameters that have not been saved non-volatile such as a temporary IP address are getting lost during the reset.

   Please confirm you want to reset the device.

   Submit  Cancel

   ![Figure 21: Reset via HTTP (as depicted in Internet Explorer)]

   **Important:**

   Please note the following consequences of a reset:
   - The firmware is being restarted and connections will be interrupted or timed out.
   - I/O bus communication is being stopped.
   - A temporary IP address assigned by the Ethernet Device Configuration Tool will be lost.

2. Perform reset.
   - Activate the checkbox in front of **Please confirm**... to acknowledge that you want to reset the device.

   **Note:**

   You can use the **Cancel** button to uncheck the checkbox in front of **Please confirm**...

   - Click **Submit** button to start the reset.
   - The device is reset.
12 Firmware recovery via HTTP

12.1 Overview

If the **POW** system status LED of the gateway shows steady green light, the “regular” firmware of the gateway is defective or missing (for the position of the **POW** LED see section *Positions of the LEDs* [page 28]).

In this case only the so-called “backup firmware” is running and the device is not able to perform its normal gateway functions. This state can be resolved by downloading a fresh (i. e. uncorrupted) firmware file into the gateway via HTTP protocol. The backup firmware (which is part of the boot strap loader running in the gateway) carries a “web server” functionality for downloading a firmware file comfortably via its Ethernet interface.

For this, you just have to connect the gateway via its Ethernet interface to an active DHCP server and a configuration PC. The purpose of the DHCP server is to assign an IP address to the gateway. This assigned IP address can then be used by the configuration PC to connect to the download function of the backup firmware running in the gateway, in order to download the new firmware file via ordinary web browser.

If you do not know the exact IP address assigned to the gateway by the DHCP server, you can use the Hilscher **Ethernet Device Configuration Tool** on your configuration PC (included on the product DVD) in order to “read out” the newly assigned IP address from the gateway. (The tool uses the netIDENT protocol to search for all Hilscher devices within the connected IP network, and then lists all found devices and their IP addresses.)

---

*Note:*
This chapter describes only how to download the recovery firmware. Instructions on how to configure and operate a DHCP server are not subject of this manual. For information on using a DHCP server, please consult your local network administrator.

12.2 Prerequisites

- The gateway is supplied with voltage and the backup firmware inside the device is running (this is indicated by steady green light at the **POW** LED)
- The gateway is disconnected from the POWERLINK network
- The gateway is connected to an active DHCP server via local Ethernet network
- The gateway is connected via local Ethernet network to a configuration PC with installed standard web browser
Firmware recovery via HTTP

- You have access to the firmware file which you want to download to the gateway (the firmware file is stored on the SmartWire-DT Gateway Solutions product DVD in the Firmware\EU5C-SWD-POWERLINK \Vx.x.x.x folder.
- You know the IP address, which the DHCP server has assigned to the gateway. If not, install the Hilscher Ethernet Device Configuration Tool on your configuration PC. This tool allows you to check the current IP address of the gateway (if the configuration PC and the gateway are connected to the same local Ethernet network). An installer for this program can be found on the product DVD in the Software\EnDeviceCfg folder (the program can also be installed by using the menu of the product DVD.)

12.3 Step-by-step instructions

1. Use DHCP server to assign IP address to gateway.
   - Disconnect the gateway from the voltage supply.
   - Plug a cable connected to the local Ethernet network (in which a DHCP server is active) into one of the Ethernet RJ45 sockets (labeled LAN1-IN or LAN2-OUT) on the front side of the gateway.
   - Reconnect the gateway to the voltage supply.

   **Note:**
   The L/A LINK/Activity LEDs of the Ethernet RJ45 sockets remain dark when an Ethernet cable is plugged-in while the backup firmware is running – even if a successful IP communication with an local Ethernet network has been established.

2. Check IP address.
   - In the Windows Start menu of your configuration PC, select All Programs > Hilscher GmbH > Ethernet Device Configuration, to start the Ethernet Device Configuration Tool.
The Ethernet Device Configuration tool opens:

![Figure 22: Ethernet Device Configuration Tool](image)

- Click **Search Devices** button, to start searching for the gateway within the local Ethernet network.

- The tool starts scanning for devices and lists all found Hilscher devices and their IP addresses:

![Figure 23: Found gateway in Ethernet Device Configuration Tool](image)

- Note or write down the IP address.

  **Note:**
  If the default IP address 0.0.0.0 is displayed, the gateway has not yet received an IP address from a DHCP server. Make sure that the gateway is connected to a subnet with an active DHCP server. Then restart the gateway by briefly disconnecting the voltage supply while the Ethernet cable remains plugged-in. Wait a few seconds after reconnecting the voltage supply, then click the **Search Devices** button in the Ethernet Device Configuration Tool again.

3. Open web page for firmware download.

- Start the web browser on your configuration PC.
- In the address bar of your browser, enter the IP address of the gateway: http://<IP address>
The **Firmware Update** page opens:

![Firmware Update page](image)

**Figure 24: Firmware recovery via HTTP (as depicted in Internet Explorer)**

4. Select firmware file for download.
   - Click **Browse**... button, to open a dialog window for selecting the firmware file you want to download.
   - Navigate to the directory in which the firmware file is stored, select the file, then click **Open**.

   **Note:**
   The name of the firmware file for the EU5C-SWD-POWERLINK gateway is `E030K0U0.nxf`

   Path and name of the selected file are displayed in the field next to the **Browse**... button.

5. Download firmware file to gateway.
   - Click **Transfer** button to download the new firmware file to the gateway.
After you have started the download by clicking the **Transfer** button, the validity of the firmware file is being checked by the system. If the file fails the validity check, an error message will be displayed. If the file passes, the gateway requests you to perform a reset in order to start the new firmware:

![Figure 25: Reset after firmware download via HTTP (as depicted in Internet Explorer)](image)

6. Perform reset.
   - Activate the checkbox in front of **Please confirm...** to acknowledge that you want to reset the gateway.
   
   **Note:**
   You can use the **Cancel** button to uncheck the checkbox in front of **Please confirm...**
   
   - Click **Submit** button to start the reset.
   - After successful reset, the following message is displayed:

   ![Figure 26: Successful device reset message (as depicted in Internet Explorer)](image)

   - The **POW** system status LED at the gateway shows steady yellow light. The new firmware has been loaded and the gateway is ready for operation.
## 13 Technical data

### 13.1 Technical data EU5C-SWD-POWERLINK gateway

<table>
<thead>
<tr>
<th>Category</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>Part number</td>
<td>9233.920</td>
</tr>
<tr>
<td></td>
<td>Dimensions (W x H x D)</td>
<td>35 x 90 x 127 mm</td>
</tr>
<tr>
<td></td>
<td>Weight</td>
<td>160 g</td>
</tr>
<tr>
<td></td>
<td>Mounting</td>
<td>Top hat rail 35 mm (IEC/EN 60715)</td>
</tr>
<tr>
<td></td>
<td>Mounting position</td>
<td>Vertical</td>
</tr>
<tr>
<td></td>
<td>Standards</td>
<td>IEC/EN 61131-2</td>
</tr>
<tr>
<td></td>
<td>Communication controller</td>
<td>netX 50 processor</td>
</tr>
<tr>
<td></td>
<td>Configuration and diagnostic interface</td>
<td>Mini-USB</td>
</tr>
<tr>
<td></td>
<td>Integrated memory</td>
<td>8 MB SDRAM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 MB serial Flash EPROM</td>
</tr>
<tr>
<td><strong>Ambient mechanical conditions</strong></td>
<td>Protection type</td>
<td>IP20</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 60529, EN50178, VBG 4)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vibrations</td>
<td>Constant amplitude 3.5 mm: 5 – 9 Hz</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 61131-2:2008)</td>
<td>Constant acceleration 1 g: 9 – 150 Hz</td>
</tr>
<tr>
<td></td>
<td>Mechanical shock resistance</td>
<td>Semi-sinusoidal 15 g/11 ms: 9 Shocks</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 60068-2-27)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Drop to (IEC/EN 60068-2-31)</td>
<td>Drop height: 50 mm</td>
</tr>
<tr>
<td></td>
<td>Free fall, packaged (IEC/EN 60068-2-32)</td>
<td>Drop height: 1 m</td>
</tr>
<tr>
<td><strong>Ambient climatic conditions</strong></td>
<td>Operating ambient temperature</td>
<td>-25…+55 °C</td>
</tr>
<tr>
<td></td>
<td>(IEC 60068-2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Condensation</td>
<td>Prevent by suitable measures</td>
</tr>
<tr>
<td></td>
<td>Storage</td>
<td>-40…+70 °C</td>
</tr>
<tr>
<td></td>
<td>Relative humidity, non-condensing</td>
<td>5…95 %</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 60068-2-30)</td>
<td></td>
</tr>
<tr>
<td><strong>Electromagnetic compatibility (EMC)</strong></td>
<td>Pollution degree</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Electrostatic discharge</td>
<td>Air discharge (Level 3): 8 kV</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 61131-2:2008)</td>
<td>Contact discharge (Level 2): 4 kV</td>
</tr>
<tr>
<td></td>
<td>Electromagnetic fields</td>
<td>80 – 1000 MHz: 10 V/m</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 61131-2:2008)</td>
<td>1.4 – 2 GHz: 3 V/m</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 – 2.7 GHz: 1 V/m</td>
</tr>
<tr>
<td></td>
<td>Radio interference suppression</td>
<td>EN 55011 Class A</td>
</tr>
<tr>
<td></td>
<td>(SmartWire-DT)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Burst</td>
<td>Supply cables: 2 kV</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 61131-2:2008, Level 3)</td>
<td>POWERLINK bus cable: 1 kV</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SmartWire-DT cables: 1 kV</td>
</tr>
<tr>
<td></td>
<td>Surge</td>
<td>Supply cables: 0.5 kV</td>
</tr>
<tr>
<td></td>
<td>(IEC/EN 61131-2:2008, Level 1)</td>
<td>POWERLINK bus cable: 1 kV</td>
</tr>
<tr>
<td></td>
<td>Radiated RFI</td>
<td>0.15 – 80 MHz, 10 V, 80% AM / 1 KHz</td>
</tr>
<tr>
<td>Category</td>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supply voltage $U_{\text{AUX}}$</td>
<td>Rated operational voltage</td>
<td>$24 \text{ V DC}$</td>
</tr>
<tr>
<td></td>
<td>Input voltage residual ripple</td>
<td>$\leq 5%$</td>
</tr>
<tr>
<td></td>
<td>Protection against polarity reversal</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>max. current $I_{\text{max}}$</td>
<td>$3 \text{ A}$</td>
</tr>
<tr>
<td></td>
<td>Note: If contactors with a total power consumption $&gt; 3 \text{ A}$ are connected, a power feeder module EU5C-SWD-PF1/2 has to be used.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Short-circuit strength</td>
<td>$\text{No}$, external fuse FAZ Z3</td>
</tr>
<tr>
<td></td>
<td>Heat dissipation</td>
<td>$\text{Typ. 1 W}$</td>
</tr>
<tr>
<td></td>
<td>Potential isolation</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Rated operating voltage of 24-V-DC slaves</td>
<td>Typical $U_{\text{AUX}} - 0.2 \text{ V}$</td>
</tr>
<tr>
<td>Supply voltage $U_{\text{POW}}$</td>
<td>Supply voltage</td>
<td>$24 \text{ V DC}$</td>
</tr>
<tr>
<td></td>
<td>Input voltage residual ripple</td>
<td>$\leq 5%$</td>
</tr>
<tr>
<td></td>
<td>Protection against polarity reversal</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Rated operational current $I_{\text{max}}$</td>
<td>$111 \text{ mA (with two participants)}$</td>
</tr>
<tr>
<td></td>
<td>Heat dissipation</td>
<td>$2.66 \text{ W (with two participants)}$</td>
</tr>
<tr>
<td></td>
<td>Potential isolation between $U_{\text{POW}}$ and 15-V-SmartWire-DT supply voltage</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Bridging voltage dips</td>
<td>$10 \text{ ms}$</td>
</tr>
<tr>
<td></td>
<td>Repeat rate</td>
<td>$1 \text{ s}$</td>
</tr>
<tr>
<td></td>
<td>Status display</td>
<td>$\text{POW LED}$</td>
</tr>
<tr>
<td>SmartWire-DT supply voltage</td>
<td>Rated operational voltage $U_e$</td>
<td>$15 \text{ V } \pm 3%$</td>
</tr>
<tr>
<td></td>
<td>max. current $I_{\text{max}}$</td>
<td>$0.7 \text{ A}$</td>
</tr>
<tr>
<td></td>
<td>Note: If contactors with a total power consumption $&gt; 0.7 \text{ A}$ are connected, a power feeder module EU5C-SWD-PF2 has to be used.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Short-circuit strength</td>
<td>Yes</td>
</tr>
<tr>
<td>Connection supply voltages</td>
<td>Connection type</td>
<td>Push-in terminals</td>
</tr>
<tr>
<td></td>
<td>solid</td>
<td>$0.2 – 1.5 \text{ mm}^2$ (AWG 24 – 16)</td>
</tr>
<tr>
<td></td>
<td>Flexible with ferrule</td>
<td>$0.25 – 1.5 \text{ mm}^2$</td>
</tr>
<tr>
<td>SmartWire-DT network</td>
<td>Participant type</td>
<td>SmartWire-DT master</td>
</tr>
<tr>
<td></td>
<td>SmartWire-DT Master ASIC</td>
<td>SWD-80P-RS485</td>
</tr>
<tr>
<td></td>
<td>Number of SmartWire-DT slaves</td>
<td>99</td>
</tr>
<tr>
<td></td>
<td>Baud rate</td>
<td>$125 / 250 \text{ kBd}$</td>
</tr>
<tr>
<td></td>
<td>Address setting</td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>Status display</td>
<td>SmartWire-DT master: $\text{SWD LED, duo color red/green}$</td>
</tr>
<tr>
<td></td>
<td>Configuration: $\text{Config LED, duo color red/green}$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Connections</td>
<td>Plug, 8-pole</td>
</tr>
<tr>
<td></td>
<td>Plug connectors</td>
<td>Blade terminal SWD4-8MF2</td>
</tr>
<tr>
<td>Category</td>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ethernet POWERLINK network</td>
<td>Function of gateway</td>
<td>POWERLINK Controlled Node (Slave)</td>
</tr>
<tr>
<td></td>
<td>Baud rate</td>
<td>100 MBit/s</td>
</tr>
<tr>
<td></td>
<td>Interface type</td>
<td>100 BASE-TX</td>
</tr>
<tr>
<td></td>
<td>Half duplex/full duplex</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>Auto-Negotiation</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>Auto-Crossover</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>Address setting</td>
<td>By project configuration</td>
</tr>
<tr>
<td></td>
<td>Status display</td>
<td>POWERLINK Controlled Node: <strong>APL, BS, BE</strong> LEDs, duo color red/green</td>
</tr>
<tr>
<td></td>
<td>Connector socket</td>
<td>2 x RJ45</td>
</tr>
<tr>
<td></td>
<td>Connector plug</td>
<td>RJ45</td>
</tr>
<tr>
<td></td>
<td>Potential isolation</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Table 32: Technical data EU5C-SWD-POWERLINK gateway*
## 13.2 POWERLINK

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of cyclic input data</td>
<td>1490 bytes</td>
</tr>
<tr>
<td>Maximum number of cyclic output data</td>
<td>1490 bytes</td>
</tr>
<tr>
<td>Acyclic data transfer</td>
<td>SDO Upload/Download</td>
</tr>
<tr>
<td>Functions</td>
<td>SDO over ASND and UDP</td>
</tr>
<tr>
<td>Baud rate</td>
<td>100 MBit/s, half-duplex</td>
</tr>
<tr>
<td>Data transport layer</td>
<td>Ethernet II, IEEE 802.3</td>
</tr>
<tr>
<td>Ethernet POWERLINK version</td>
<td>V 2</td>
</tr>
<tr>
<td>Limitation</td>
<td>No slave to slave communication</td>
</tr>
<tr>
<td>Reference to firmware/stack version</td>
<td>V2.1.x.x</td>
</tr>
</tbody>
</table>

*Table 33: Technical Data POWERLINK Controlled Node (Slave) Protocol*
List of figures

Figure 1: Data flow EU5C-SWD-POWERLINK gateway ................................................................. 21
Figure 2: Pinning of the Ethernet interface (RJ45) ................................................................. 31
Figure 3: Mounting principle of the gateway ........................................................................... 35
Figure 4: Gateway power supply ............................................................................................ 39
Figure 5: Connecting SmartWire-DT to gateway ................................................................. 40
Figure 6: Connecting POWERLINK to gateway ...................................................................... 41
Figure 7: SmartWire-DT Installation Wizard ........................................................................... 45
Figure 8: Start Window of SWD-Assist .................................................................................. 47
Figure 9: Communication View in SWD-Assist ........................................................................ 48
Figure 10: Target Configuration in SWD-Assist ...................................................................... 48
Figure 11: Planned Configuration in SWD-Assist: Set Device Parameters ......................... 49
Figure 12: Planned Configuration in SWD-Assist: Set POWERLINK Parameters of Gateway ........................................................................................................... 50
Figure 13: Planned configuration in SWD-Assist .................................................................... 52
Figure 14: POWERLINK project in Automation Studio .......................................................... 53
Figure 15: Select controller module dialog in Automation Studio ........................................ 53
Figure 16: Module Parameter dialog in Automation Studio .................................................... 54
Figure 17: Gateway in POWERLINK project ......................................................................... 54
Figure 18: Open I/O mapping ................................................................................................. 55
Figure 19: I/O Mapping of SWD slaves .................................................................................. 55
Figure 20: Firmware update via HTTP (as depicted in Internet Explorer) ............................. 67
Figure 21: Reset via HTTP (as depicted in Internet Explorer) .................................................. 69
Figure 22: Ethernet Device Configuration Tool ........................................................................ 72
Figure 23: Found gateway in Ethernet Device Configuration Tool .......................................... 72
Figure 24: Firmware recovery via HTTP (as depicted in Internet Explorer) .......................... 73
Figure 25: Reset after firmware download via HTTP (as depicted in Internet Explorer) .... 74
Figure 26: Successful device reset message (as depicted in Internet Explorer) .................... 74
List of tables

Table 1: List of revisions ................................................................. 5
Table 2: Reference to hardware and firmware ................................... 7
Table 3: Reference to software tools ................................................... 7
Table 4: Reference to drivers ............................................................. 7
Table 5: Directory of the product DVD .............................................. 9
Table 6: Documentation overview .................................................... 12
Table 7: Signal words in safety messages on personal injury ............... 20
Table 8: Safety signs in messages on personal injury ......................... 20
Table 9: Signal words in safety messages on property damage ............. 20
Table 10: Safety signs in safety messages on property damage .......... 20
Table 11: Front view EU5C-SWD-POWERLINK gateway .................... 27
Table 12: LEDs EU5C-SWD-POWERLINK gateway ............................ 28
Table 13: Descriptions of the LEDs ................................................ 29
Table 14: Description of the LEDs (2) ............................................ 29
Table 15: Ethernet interface channel 0 and channel 1 pin assignment (RJ45) ................................................................. 31
Table 16: Device type label EU5C-SWD-POWERLINK ....................... 32
Table 17: Getting started ............................................................... 33
Table 18: Elements read request SDO Write .................................... 56
Table 19: Example read request SDO Write ..................................... 56
Table 20: Elements write request SDO Write ................................... 57
Table 21: Example write request SDO Write ................................... 57
Table 22: Elements SDO Read ....................................................... 58
Table 23: Example SDO Read ....................................................... 58
Table 24: Structure of Error Entry .................................................. 60
Table 25: Examples of diagnostic codes of SWD slaves ...................... 61
Table 26: Error Entry for new ("incoming") error/diagnosis of SWD slave 61
Table 27: Error Entry for resolved error of SWD slave ....................... 62
Table 28: Error Flags in case of bus error/status messages generated by the gateway ............................................................. 63
Table 29: Error Entry for incoming error on SWD bus ....................... 64
Table 30: Error Entry in case of resolved SWD bus error .................... 64
Table 31: Controls in Firmware Update Page ................................... 68
Table 32: Technical data EU5C-SWD-POWERLINK gateway .............. 75
Table 33: Technical Data POWERLINK Controlled Node (Slave) Protocol ................................................................. 78
Contacts

HEADQUARTERS

Germany
Hilscher Gesellschaft für Systemautomation mbH
Rheinstrasse 15
D-65795 Hattersheim
Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-Mail: info@hilscher.com
Support
Phone: +49 (0) 6190 9907-99
E-Mail: de.support@hilscher.com

SUBSIDIARIES

China
Hilscher Systemautomation (Shanghai) Co. Ltd.
200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-Mail: info@hilscher.cn
Support
Phone: +86 (0) 21-6355-5161
E-Mail: cn.support@hilscher.com

France
Hilscher France S.a.r.l.
69500 Bron
Phone: +33 (0) 4 72 37 98 40
E-Mail: info@hilscher.fr
Support
Phone: +33 (0) 4 72 37 98 40
E-Mail: fr.support@hilscher.com

India
Hilscher India Pvt. Ltd.
Pune, Delhi, Mumbai
Phone: +91 8888 750 777
E-Mail: info@hilscher.in

Italy
Hilscher Italia S.r.l.
20090 Vimodrone (MI)
Phone: +39 02 25007068
E-Mail: info@hilscher.it
Support
Phone: +39 02 25007068
E-Mail: it.support@hilscher.com

Japan
Hilscher Japan KK
Tokyo, 160-0022
Phone: +81 (0) 3-5362-0521
E-Mail: info@hilscher.jp
Support
Phone: +81 (0) 3-5362-0521
E-Mail: jp.support@hilscher.com

Korea
Hilscher Korea Inc.
Seongnam, Gyeonggi, 463-400
Phone: +82 (0) 31-789-3715
E-Mail: info@hilscher.kr

Switzerland
Hilscher Swiss GmbH
4500 Solothurn
Phone: +41 (0) 32 623 6633
E-Mail: info@hilscher.ch
Support
Phone: +49 (0) 6190 9907-99
E-Mail: ch.support@hilscher.com

USA
Hilscher North America, Inc.
Lisle, IL 60532
Phone: +1 630-505-5301
E-Mail: info@hilscher.us
Support
Phone: +1 630-505-5301
E-Mail: us.support@hilscher.com